Notice
The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.
©September 2015

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
Preface

R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Directive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Luxembourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland, United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slovenia.

ErP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC) regulations on power consumption in off mode:

- Off Mode < 0.5W
CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has attained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies to products regulated by certain European health, safety and environmental protection legislation. The CE Mark is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE Marking. A notified body has determined that this device has properly demonstrated that the requirements of the directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product. Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
Preface

FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not inst-alled and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
   And
2. This device must accept any interference, including interference that may cause undesired operation of the device.
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

**Warning**

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit:

- Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz DC Output 19.5V, 6.15A (120 Watts) minimum

This Computer’s Optical Device is a Laser Class 1 Product
Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the Vents/Fan Intakes.
Preface

3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>

5. Take care when using peripheral devices.

<table>
<thead>
<tr>
<th>Use only approved brands of peripherals.</th>
<th>Unplug the power cord before attaching peripheral devices.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
</tbody>
</table>
Preface

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and may expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Bottom Cover Removal Warning

Users should not remove any cover(s) and/or screw(s) for the purposes of device upgrade as this may violate the terms of your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your distributor/supplier for further information.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before restoring power to the system.

Also note the following when the cover is removed:

- Hazardous moving parts.
- Keep away from moving fan blades.
Power Safety
The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

Power Safety Warning
Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines and power cord).

You must also remove your battery in order to prevent accidentally turning the machine on. Before removing the battery disconnect the AC/DC adapter from the computer.
**Polymer Battery Precautions**

Note the following information which is specific to polymer batteries only, and where applicable, this overrides the general battery precaution information overleaf.

- Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mechanism and is not a cause for concern.
- Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient temperature environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
Preface

General Battery Precautions

• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply and then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before restoring power to the system.
Also note the following when the cover is removed:
• Hazardous moving parts.
• Keep away from moving fan blades.
Preface

Travel Considerations
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Preface

Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:

- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
**Lighting**
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.

**LCD Screen Care**
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

- Set the *Windows Power Plans* to turn the screen off after a few minutes of screen idle time.
- Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
- Rotate desktop background images every few days.
- Turn the monitor off when the system is not in use.

**LCD Electro-Plated Logos**
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive. Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during transport. If any such wear and tear develops contact your distributor/supplier.
Preface
Contents

Notice .............................................................................................................................................................I
ErP Off Mode Power Consumption Statement: ........................................................................................... II
FCC Statement ............................................................................................................................................IV
FCC RF Radiation Exposure Statement: ............................................................................................... V
Instructions for Care and Operation ................................................................................................. VII
Servicing .....................................................................................................................................................IX
Power Safety ........................................................................................................................................... X
Polymer Battery Precautions ............................................................................................................... XI
General Battery Precautions .................................................................................................................. XII
Cleaning ................................................................................................................................................... XIII
Servicing .................................................................................................................................................. XIII
Travel Considerations ........................................................................................................................... XIV

Quick Start Guide

Overview ....................................................................................................................................................1-1
Advanced Users .........................................................................................................................................1-2
Beginners and Not-So-Advanced Users ...........................................................................................1-2
Warning Boxes .......................................................................................................................................1-2
Not Included ..........................................................................................................................................1-3
System Software .....................................................................................................................................1-4
System Startup .......................................................................................................................................1-5
# Preface

- Model Differences ...................................................................................................................... 1-6
- LCD Panel Open - Model A ........................................................................................................ 1-7
- LCD Panel Open - Model B ........................................................................................................ 1-8
- LCD Panel Open - Model C ........................................................................................................ 1-9
- LED Indicators ............................................................................................................................ 1-10
- Illuminated LED Keyboard .......................................................................................................... 1-11
- Control Center ............................................................................................................................ 1-12
- Flexikey® Application ................................................................................................................. 1-13
- Flexikey® Application Features: ............................................................................................... 1-14
- Keyboard Shortcuts ..................................................................................................................... 1-15
- Function Keys & Visual Indicators ............................................................................................... 1-16
- Front & Rear Views ....................................................................................................................... 1-17
- Right View .................................................................................................................................. 1-18
- Left View .................................................................................................................................... 1-20
- Bottom View - Model A .............................................................................................................. 1-22
- Bottom View - Model B .............................................................................................................. 1-23
- Bottom View - Model C .............................................................................................................. 1-24
- Windows 10 Start Menu ............................................................................................................. 1-25
- Right-Clicking the Windows Logo In Start Menu ....................................................................... 1-26
- Start Menu Apps & Tiles .............................................................................................................. 1-27
- Windows 10 Control Panel ......................................................................................................... 1-29
- Settings ....................................................................................................................................... 1-30
Windows 10 Taskbar ................................................................. 1-31
Video Features ........................................................................ 1-32
Power Options ........................................................................ 1-37

Storage Devices, Mouse, & Audio
Overview .................................................................................. 2-1
Hard Disk Drive/Solid State Drive ........................................... 2-2
Optical (CD/DVD) Device ....................................................... 2-3
Loading Discs .......................................................................... 2-3
Handling CDs or DVDs ............................................................ 2-4
DVD Regional Codes ............................................................... 2-5
Multi-in-1 Card Reader ............................................................ 2-6
Setup for Audio Recording ....................................................... 2-6
Audio Features ........................................................................ 2-7
Setup for Audio Recording ....................................................... 2-8
Touchpad and Buttons/Mouse ............................................... 2-9
Touchpad Sensitivity ............................................................... 2-10
Touchpad Configuration .......................................................... 2-11
Gestures and Device Settings .................................................. 2-12

Power Management
Overview .................................................................................. 3-1
The Power Sources .................................................................. 3-2
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC/DC Adapter</td>
<td>3-2</td>
</tr>
<tr>
<td>Battery</td>
<td>3-2</td>
</tr>
<tr>
<td>Turning On the Computer</td>
<td>3-3</td>
</tr>
<tr>
<td>Shutting the Computer Down</td>
<td>3-4</td>
</tr>
<tr>
<td>Power Plans</td>
<td>3-5</td>
</tr>
<tr>
<td>Power-Saving States</td>
<td>3-7</td>
</tr>
<tr>
<td>Sleep</td>
<td>3-7</td>
</tr>
<tr>
<td>Hibernate</td>
<td>3-8</td>
</tr>
<tr>
<td>Shut down</td>
<td>3-8</td>
</tr>
<tr>
<td>Configuring the Power Buttons</td>
<td>3-9</td>
</tr>
<tr>
<td>Resuming Operation</td>
<td>3-11</td>
</tr>
<tr>
<td>Power Conservation Modes</td>
<td>3-12</td>
</tr>
<tr>
<td>Settings Menu Power Controls</td>
<td>3-14</td>
</tr>
<tr>
<td>Battery Information</td>
<td>3-17</td>
</tr>
<tr>
<td>Battery Power</td>
<td>3-17</td>
</tr>
<tr>
<td>Conserving Battery Power</td>
<td>3-18</td>
</tr>
<tr>
<td>Battery Life</td>
<td>3-19</td>
</tr>
<tr>
<td>New Battery</td>
<td>3-19</td>
</tr>
<tr>
<td>Recharging the Battery with the AC/DC Adapter</td>
<td>3-19</td>
</tr>
<tr>
<td>Proper handling of the Battery Pack</td>
<td>3-20</td>
</tr>
<tr>
<td>Battery FAQ</td>
<td>3-21</td>
</tr>
</tbody>
</table>
Drivers & Utilities

What to Install ................................................................. 4-1
Module Driver Installation ......................................................... 4-1
Driver Installation ................................................................. 4-2
Updating/Reinstalling Individual Drivers ................................. 4-5
User Account Control ............................................................. 4-6
Windows Security Message .................................................... 4-6
New Hardware Found ........................................................... 4-6
Driver Installation Procedure .................................................. 4-7
Chipset ........................................................................ 4-7
Video (VGA) ........................................................................ 4-7
NVIDIA Video (VGA) ............................................................. 4-7
LAN ............................................................................. 4-7
Card Reader ....................................................................... 4-7
Touchpad ......................................................................... 4-8
Airplane .......................................................................... 4-8
Control Center .................................................................. 4-8
MEI Driver ....................................................................... 4-8
Audio .............................................................................. 4-8
Optional Drivers ................................................................. 4-10
Preface

BIOS Utilities
Overview ....................................................................................................................................................5-1
The Power-On Self Test (POST) ...............................................................................................................5-2
Failing the POST ........................................................................................................................................5-3
Fatal Errors ................................................................................................................................................5-3
Non-Fatal Errors ......................................................................................................................................5-3
The Setup Utility ......................................................................................................................................5-4
Entering Setup ........................................................................................................................................5-4
Setup Screens .......................................................................................................................................5-5
Main Menu ............................................................................................................................................5-6
System Time & Date (Main Menu) ...........................................................................................................5-6
SATA Port # (Main Menu) .........................................................................................................................5-7
OffBoard SATA Controller Configuration (Main Menu) .................................................................5-7
ME FW Version/System/Extended Memory (Main Menu) ...............................................................5-7
MB Series/BIOS Revision/KBC/EC firmware Revision/Mac Address (Main Menu) .........................5-7
Advanced Menu ...................................................................................................................................5-8
Intel(R) Rapid Start Technology (Advanced Menu) .............................................................................5-8
GPU Performance Scaling (Advanced Menu > Advanced Chipset Control) .....................................5-9
FlexiCharger (Advanced Menu > Advanced Chipset Control) ..............................................................5-9
SATA Mode (Advanced Menu) ...............................................................................................................5-10
Boot Logo (Advanced Menu) ..................................................................................................................5-10
Power On Boot Beep (Advanced Menu) ...............................................................................................5-10
Troubleshooting
Overview ....................................................................................................................................................7-1
Basic Hints and Tips ..................................................................................................................................7-2
Backup and General Maintenance .............................................................................................................7-3
Viruses .......................................................................................................................................................7-4
Upgrading and Adding New Hardware/Software ......................................................................................7-5
Problems and Possible Solutions ...............................................................................................................7-7

Interface (Ports & Jacks)
Overview .....................................................................................................................................................A-1
Ports and Jacks ..........................................................................................................................................A-2
Card Reader ................................................................................................................................................A-2
DC-In Jack ................................................................................................................................................A-2
External Monitor (VGA) Port ...................................................................................................................A-2
Mini DisplayPort 1.2 ................................................................................................................................A-2
HDMI-Out Port ..........................................................................................................................................A-3
Headphone-Out Jack ...............................................................................................................................A-3
Microphone-In Jack ................................................................................................................................A-3
RJ-45 LAN Jack .......................................................................................................................................A-3
S/PDIF-Out Jack ......................................................................................................................................A-3
Security Lock Slot ..................................................................................................................................A-3
USB 3.0 Port .............................................................................................................................................A-4
Preface

Control Center & Flexikey®

Overview ................................................................................................................................................... B-1
Control Center .......................................................................................................................................... B-1
Flexikey® ................................................................................................................................................ B-1
Power Modes .......................................................................................................................................... B-3
Control Center Menus ............................................................................................................................... B-4
Power Status (System Program) ............................................................................................................... B-5
Brightness (System Program) .................................................................................................................. B-5
Volume (System Program) ....................................................................................................................... B-5
Fan Speed (System Program) ................................................................................................................... B-5
This system supports Power Saving power ............................................................................................ B-6
Sleep Button (System Program) ............................................................................................................... B-6
Desktop Background (System Program) .................................................................................................. B-6
Display Switch (System Program) .......................................................................................................... B-6
Time Zone (System Program) .................................................................................................................. B-6
TouchPad/Camera (Device) .................................................................................................................... B-7
Caps Lock/Scroll Lock/ Number Lock/Airplane Mode .......................................................................... B-7
Left Windows Key (Gaming) ................................................................................................................... B-7
Headphone (Gaming) ............................................................................................................................... B-7
Flexikey® (Gaming) ............................................................................................................................... B-7
Flexikey® Application ............................................................................................................................ B-8
Language Interface ................................................................................................................................. B-9
Keyboard Settings - Express Key ...........................................................................................................B-13
Enabling Time Record .............................................................................................................................B-15
Keyboard Settings - Launch App ...............................................................................................................B-17
Keyboard Settings - Express Text ..........................................................................................................B-19
Keyboard Settings - Disable ....................................................................................................................B-21
Mouse Settings - Express Key ..................................................................................................................B-22
Enabling Time Record for Mouse Settings ............................................................................................B-23
Mouse Settings - Launch App ..................................................................................................................B-24
Mouse Settings - Express Text ................................................................................................................B-26
Mouse Settings - Disable ........................................................................................................................B-28
Statistics ..................................................................................................................................................B-29

**Video Driver Controls**

Video Driver Installation .........................................................................................................................C-1
Video (VGA) .........................................................................................................................................C-1
NVIDIA Video (VGA) ............................................................................................................................C-1
Microsoft Hybrid Graphics .....................................................................................................................C-2
Intel® Dynamic Video Memory Technology .............................................................................................C-4
Configure Other Displays Using Project ..............................................................................................C-5
You can configure attached displays from Project ..................................................................................C-5
Configuring an External Display In Windows .......................................................................................C-6
HDMI Audio Configuration ...................................................................................................................C-9
Preface

Indicators ..................................................................................................................................................D-3
Interface ...................................................................................................................................................D-3
Card Reader ..............................................................................................................................................D-3
Slots .........................................................................................................................................................D-3
Communication .........................................................................................................................................D-3
Operating System .....................................................................................................................................D-4
Features .....................................................................................................................................................D-4
Security .....................................................................................................................................................D-4
Power Management ....................................................................................................................................D-4
Power ........................................................................................................................................................D-4
Environmental Spec ..................................................................................................................................D-4
Physical Dimensions & Weight ..................................................................................................................D-4
Preface
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

- **Chapter 2** A guide to using some of the main features of the computer e.g. the storage devices (hard disk and card reader), TouchPad & Mouse and Audio Features.
- **Chapter 3** The computer’s power management options.
- **Chapter 4** The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
- **Chapter 5** An outline of the computer’s built-in software or BIOS (Basic Input Output System).
- **Chapter 6** A quick guide to the computer’s PC Camera, Wireless LAN, Fingerprint, Bluetooth & WLAN Combo, Sound Blaster Audio and Intel modules (some of which may be optional depending on your purchase configuration).
- **Chapter 7** A troubleshooting guide.
- **Appendix A** Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
- **Appendix B** Information on the Control Center. and FlexiKey Application.
- **Appendix C** Information on the Video driver controls.
- **Appendix D** The computer’s specification.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “Drivers & Utilities” on page 4 - 1 and “BIOS Utilities” on page 5 - 1 in the User’s Manual. You may also find the notes marked with a ♪ of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a ♪ as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the ☭ symbol. Also please note the safety and handling instructions as indicated in the Preface.
Not Included

Operating Systems (e.g. Windows 10) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4-1, on page 4-4. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers & Utilities” on page 4-1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A-2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
Quick Start Guide

System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the *Windows 10 (64-bit)* operating system is supported.

Windows OS

Note that the information included on the following pages is for *Windows 10 only*.

In order to run *Windows 10 (64-bit)* your computer requires a minimum 2GB of system memory (RAM).
System Startup

1. Remove all packing materials, and place the computer on a stable surface, and securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

2. **When first setting up the computer use the following procedure** (as to safeguard the computer during shipping, the battery will be locked to not power the system until first connected to the AC/DC adapter and initially set up as below):
   - Attach the AC/DC adapter cord to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter and **leave it there for 6 seconds or longer**.
   - Remove the adapter cord from the computer’s DC-In jack, and then plug it back in again; the battery will now be unlocked.

3. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 135 degrees); use the other hand to support the base of the computer (**Note: Never** lift the computer by the lid/LCD).

4. Press the power button on the top of the computer **for about 2 - 3 seconds** to turn the computer “on” (note that the power LED on the front of the computer **will turn from orange to white** when the computer powers on).

---

**Shutdown**

Note that you should always shut your computer down by choosing the **Shut Down command in Windows** (see page **1 - 33**). This will help prevent hard disk or system problems.

---

*Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD*
Quick Start Guide

Model Differences
This notebook series includes three different model types that mainly differ as indicated in the table below. Note that your model may appear slightly different from those pictured in this manual.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Model A</th>
<th>Model B</th>
<th>Model C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Style</td>
<td>See Page 1 - 7</td>
<td>See Page 1 - 8</td>
<td>See Page 1 - 9</td>
</tr>
<tr>
<td>Display</td>
<td>15.6&quot; (39.62cm) QFHD (3840 * 2160) / FHD (1920 * 1080), 3.5 mm, 16:9 Backlit Panel</td>
<td>17.3&quot; (43.94cm) FHD (1920 * 1080), 6.0mm, 16:9 Backlit Panel</td>
<td></td>
</tr>
<tr>
<td>Card Slots</td>
<td>Three M.2 Slots</td>
<td>Two M.2 Slots</td>
<td></td>
</tr>
<tr>
<td>3G/4G Module</td>
<td>Supported</td>
<td>Not Supported</td>
<td></td>
</tr>
</tbody>
</table>

Table 1 - 1 - Model Differences
Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices (e.g. WLAN, Bluetooth or 3G/4G) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF (i.e. the system is in Airplane Mode) if you are using the computer aboard aircraft.

Use Fn + F11 Airplane Mode key combination to toggle Airplane Mode On/Off, and check the LED indicator for the power status.

Note that the Touchpad/Clickpad and Buttons has a valid operational area indicated within the dotted lines on the left.
1. Built-In PC Camera
2. PC Camera LED
3. Built-In Microphone
4. Built-In Array Microphone
5. LCD
6. Speakers
7. Power Button
8. LED Indicators
9. Illuminated (White) LED Keyboard
10. TouchPad & Buttons
11. Fingerprint Reader Sensor (Optional)

Note that the Touchpad/Clickpad and Buttons has a valid operational area indicated within the dotted lines on the right.

---

**Wireless Device Operation Aboard Aircraft**

The use of any portable electronic transmission devices (e.g. WLAN, Bluetooth or 3G/4G) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF (i.e. the system is in Airplane Mode) if you are using the computer aboard aircraft.

Use Fn + F11 Airplane Mode key combination to toggle Airplane Mode On/Off, and check the LED indicator for the power status.
LCD Panel Open - Model C

Figure 1 - 4
LCD Panel Open
Model C

1. Built-In PC Camera
2. PC Camera LED
3. Built-In Microphone
4. Built-In Array Microphone
5. LCD
6. Speakers
7. Power Button
8. Illuminated (White) LED Keyboard
9. TouchPad & Buttons
10. Fingerprint Reader Sensor (Optional)

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices (e.g. WLAN, Bluetooth or 3G/4G) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF (i.e. the system is in Airplane Mode) if you are using the computer aboard aircraft.

Use Fn + F11 Airplane Mode key combination to toggle Airplane Mode On/Off, and check the LED indicator for the power status.

Note that the Touchpad/Clickpad & Buttons has a valid operational area indicated within the dotted lines on the left.
LED Indicators

The LED indicators on the computer display helpful information about the current status of the system.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Airplane Mode icon]</td>
<td>White</td>
<td><strong>Airplane Mode is ON</strong> (the WLAN, Bluetooth &amp; 3G/4G Modules are OFF)</td>
<td>![Battery Charging icon]</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td>![HDD Activity icon]</td>
<td>White</td>
<td><strong>HDD Activity</strong></td>
<td>![Blinking Battery icon]</td>
<td>Blinking Orange</td>
<td>The Battery has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>![Number Lock icon]</td>
<td>White</td>
<td><strong>Number Lock is Activated</strong></td>
<td>![Battery Full icon]</td>
<td>White</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td>![Caps Lock icon]</td>
<td>White</td>
<td><strong>Caps Lock is Activated</strong></td>
<td>![AC/DC Power icon]</td>
<td>Orange</td>
<td>AC/DC Power is Plugged In</td>
</tr>
<tr>
<td>![Scroll Lock icon]</td>
<td>White</td>
<td><strong>Scroll Lock is Activated</strong></td>
<td>![Computer On icon]</td>
<td>White</td>
<td>The Computer is On</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Blinking White</strong></td>
<td>![Blinking Sleep icon]</td>
<td>Blinking White</td>
<td>The Computer is in Sleep Mode</td>
</tr>
</tbody>
</table>

*Table 1 - 2 - LED Indicators*

Note that **Models A & C** have LED indicators located at the front of the computer (see *Figure 1 - 8 on page 1 - 17*). **Model B** computers have the same LED indicators, but these are located at the front and on the top case of the computer (see *Figure 1 - 3 on page 1 - 8* and *Figure 1 - 8 on page 1 - 17*).
Illuminated LED Keyboard

The white illuminated keyboard has an embedded numerical keypad for easy numeric data input, and features function keys to allow you to change operational features instantly. See Table 1 - 4, on page 1 - 16 for full function key combination details.

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may not work.

Scr Lk

Hold down the Fn Key and Scr Lk to enable scroll lock/number lock, and check the LED indicator for status.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.
Control Center

When in the Windows Desktop application (not in the Start screen) press the **Fn + Esc** key combination, or double-click the icon in the notification area of the taskbar to toggle the Control Center on/off. The Control Center gives quick access to frequently used controls and enables you to quickly turn the camera/Touch Pad on/off (see Appendix B for full details).

![Figure 1-6 - Control Center](image)

**Control Center Access**

To run the Control Center press the **Fn + Esc** key combination, or double-click the icon in the notification area of the taskbar.

Close the Control Center by clicking the close icon in the top right of the panel (move the cursor onto the top right corner of the panel to highlight it).
Flexikey® Application

The Flexikey® application is a quick hotkey configuration application, which allows you to assign a single key to launch multiple key combinations, or to launch programs and applications, to create text macros and to disable certain keys. The application can also be used to configure the mouse buttons to create hotkeys for gaming etc. All the configuration settings are retained under (up to 12) profiles to which the settings are applied. Click Flexikey® in the Gaming section of the Control Center, or the click the icon in the notification area of the taskbar, to launch the application (see Appendix B for full details).

Figure 1 - 7 - Flexikey® Hotkey Application
Quick Start Guide

Flexikey® Application Features:
For full details see “Flexikey® Application” on page B - 8.

- **EXPRESS KEY** - This feature allows you to configure a single key (or mouse click) to send multiple key combinations, or to create more useful shortcut keys. This is useful in gaming or when using applications which have a complex set of keyboard shortcuts.

- **LAUNCH APP** - This simply assigns single keys (or mouse clicks) to launch any program’s or application’s executable file.

- **EXPRESS TEXT** - With this you can assign single keys (or mouse clicks) to send commonly used strings of text.

- **DISABLE** - Use this function to disable any keyboard keys or mouse buttons.

- **STATISTICS** - Use this to quickly record keys in use in any application, and to disable unused keys.
Keyboard Shortcuts
The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navigation/operation in Windows 10.

<table>
<thead>
<tr>
<th>Windows Logo Key +</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Winkey</td>
<td>Toggle the Start menu</td>
</tr>
<tr>
<td>A</td>
<td>Open the Action Center</td>
</tr>
<tr>
<td>B</td>
<td>Select the Taskbar Notification Area</td>
</tr>
<tr>
<td>C</td>
<td>Launch Cortana (in listening mode)</td>
</tr>
<tr>
<td>D</td>
<td>Toggle the Desktop</td>
</tr>
<tr>
<td>E</td>
<td>Launch File Explorer (Quick Access tab)</td>
</tr>
<tr>
<td>+ Number (1, 2, etc)</td>
<td>Launch an application from the taskbar (numbered from left to right)</td>
</tr>
</tbody>
</table>

Table 1 - 3 - Keyboard Shortcuts

Windows Logo Keyboard Shortcut
Use the Windows logo key + D key combination to switch between the Start screen and Windows Desktop.

Menu/Application Keyboard Shortcut
When the Desktop app is running you can use the Menu/Application key on the keyboard to display the context menu as per a mouse right-click.
Quick Start Guide

Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function/Visual Indicators</th>
<th>Keys</th>
<th>Function/Visual Indicators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + 1</td>
<td>Fan Control Toggle</td>
<td>Fn + Esc</td>
<td>Control Center Toggle (see over)</td>
</tr>
<tr>
<td></td>
<td>Automatic / Full Power</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fn + Play/Pause (in Audio/Video Programs)</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + Touchpad Toggle</td>
<td>Touchpad Toggle</td>
<td>Fn + F8 F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off</td>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td></td>
<td>(Press a key to or use Touchpad to turn on)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F11</td>
<td>Airplane Mode Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Backlight Keyboard Toggle Off/High/Low</td>
<td>Fn + F12</td>
<td>Sleep Toggle</td>
</tr>
<tr>
<td>Fn + F5 F6</td>
<td>Volume Decrease/Increase</td>
<td>Fn + Backspace</td>
<td>Flexikey® Enable/Disable</td>
</tr>
</tbody>
</table>

Table 1 - 4 - Function Keys & Visual Indicators

1 - 16 Flexikey® Application
Front & Rear Views

1. LED Indicators
2. Vent/Fan Intake
3. 1 * USB 3.0 Port
4. HDMI-Out Port
5. Mini Display Port 1.2
6. DC-In Jack

HDMI Port / Mini Display Ports
Note that the HDMI Port and Mini Display Port support video and audio signals to attached external displays. Note that Sound Blaster Cinema 2 audio will be disabled when you are connecting to an external display through an HDMI or Mini Display Port connection.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.
**Right View**

1. SIM Card Reader  
   (for 3G/4G USIM Cards - Models A & B Only - see over)
2. Multi-In-1 Card Reader
3. 1 * USB 3.0 Port
4. External Monitor Port
5. RJ-45 LAN Jack

---

**Multi-in-1 Card Reader**

The card reader allows you to use the most popular digital storage card formats:  
MMC (MultiMedia Card) / RSMMC  
SD (Secure Digital) / Mini SD / SDHC / SDXC

---

**USB Ports**

Note that the connections to the USB ports only fit one way, do not force them.
3G/4G Module USIM Card Installation
(For Model A & B Computers Only)
Insert the USIM card (1) as illustrated below (pay careful attention to the orientation of the card as the gold contact side of the card should face downwards) until it clicks fully into position. To eject the card simply press it until it ejects, but do not attempt to eject the card while connected to a 3G/4G network (see below).

Note that only Model A is pictured, however the card insertion procedure for Model B is identical. Model C computers do not support a 3G/4G module.

Simply press on the USIM card to eject it, however do not do this while a connection is in progress. If you do eject the card while a 3G/4G connection is ongoing, you will need to shut down the system, reinsert the USIM card, restart the system and then reestablish the 3G/4G connection.

If you wish to change USIM cards then you will need to shut the system down, reinsert the USIM card, restart the system and then reestablish the 3G/4G connection.
Quick Start Guide

Figure 1 - 11
Left View

1. Security Lock Slot
2. 2 * USB 3.0 Ports
3. S/PDIF-Out Jack
4. Microphone Jack
5. Headphone Jack
6. Optical Device Drive Bay (for DVD Device)
Disk Eject Warning

Don’t try to eject a CD/DVD while the system is accessing it. This may cause the system to “crash”. Stop the disk first then eject it, or press the stop button twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or any object that may break and become lodged in the hole. Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (Hardware and Sound), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialog box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
Quick Start Guide

Bottom View - Model A

1. Fan Outlet/Intake
2. Battery

Battery Removal
Note that the built-in battery is not user removable. Removing the battery will violate the terms of your warranty.

If you need to remove the battery for any reason, please contact your distributor/supplier for further information.

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 17 for full instructions.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

Bottom Cover Removal Warning
Do not remove any cover(s) and/or screw(s) for the purposes of device upgrade as this may violate the terms of your warranty.

If you need to replace/replace the hard disk/RAM/optical device etc. for any reason, please contact your distributor/supplier for further information.

Figure 1 - 12
Bottom View
Model A
Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 17 for full instructions.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

Bottom Cover Removal Warning
Do not remove any cover(s) and/or screw(s) for the purposes of device upgrade as this may violate the terms of your warranty.
If you need to replace/remove the hard disk/ RAM/optical device etc. for any reason, please contact your distributor/supplier for further information.

Battery Removal
Note that the built-in battery is not user removable. Removing the battery will violate the terms of your warranty.
If you need to remove the battery for any reason, please contact your distributor/supplier for further information.

Figure 1 - 13
Bottom View
Model B
1. Fan Outlet/Intake
2. Battery
**Quick Start Guide**

**Bottom View - Model C**

1. Fan Outlet/Intake
2. Battery
3. HDD Bay

**Battery Removal**

Note that the built-in battery is not user removeable. Removing the battery will violate the terms of your warranty.

If you need to remove the battery for any reason, please contact your distributor/supplier for further information.

**Battery Information**

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 17 for full instructions.

**Overheating**

To prevent your computer from overheating, make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

**Bottom Cover Removal Warning**

Do not remove any cover(s) and/or screw(s) for the purposes of device upgrade as this may violate the terms of your warranty.

If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your distributor/supplier for further information.
Windows 10 Start Menu

Most of the apps, control panels, utilities and programs within Windows 10 can be accessed from the Start Menu by clicking the icon in the taskbar in the lower left corner of the screen (or by pressing the Windows Logo Key on the keyboard).

![Figure 1 - 15 - Windows Start Menu](image-url)
Right-Clicking the Windows Logo In Start Menu
Right-click the Start Menu icon (or use the Windows Logo Key + X key combination) to bring up an advanced Context Menu of useful features such as Control Panel, Programs and Features, Power Options, Task Manager, Search, File Explorer, Command Prompt, Device Manager and Network Connections etc.
Start Menu Apps & Tiles
The Windows 10 Start Menu will contain a number of apps, and many more will be installed as you add more applications etc. Not all of these apps can fit on the screen so may need click and drag the handles at the edge of the screen to expand the menu in order to view all the apps (you can use the scroll bar to move up and down the screen).

Figure 1 - 17 - Expanding the Start Menu
Pinning/Unpinning Apps & Programs to/from the Start Menu

To make things easy to find you can add and remove tiles for apps and programs to the Start Menu. Right-Click on a program’s icon and select **Pin to Start** from the drop-down menu. To remove an app or program from the Start Menu right-click the icon and select **Unpin from Start**. You can use the same method to pin apps/programs to/from the taskbar (select pin to taskbar/unpin this program from the taskbar).

*Figure 1 - 18 - Pin to Start/Unpin from Start*
Windows 10 Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel can be accessed in a number of ways in Windows 10.

- Right-click the Start Menu icon in the taskbar in the lower left corner of the screen and select Control Panel from the menu.
- Press the Windows logo key on your keyboard and X to bring up the context menu, and then press P to bring up the Control Panel.
- Type Control Panel into the Search box in the taskbar and click on the icon when it pops up.

Figure 1 - 19 - Windows 10 Control Panel Access
Quick Start Guide

Settings
The Settings item in the Start Menu (and also as an App) gives you quick access to a number of system settings control panels allowing you to adjust settings for System, Devices, Network & internet, Personalization, Accounts, Time & language, Ease of Access, Privacy and Update & security.

Figure 1 - Settings
Windows 10 Taskbar

In many instances throughout this manual you will see an instruction to access the notification area of the taskbar. The notification area of the taskbar in the bottom right of the screen. Some of the Control Panels and applications referred to throughout the course of this manual can be accessed from here.

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Pining/Unpinning Apps & Programs to/from the Start Menu” on page 1 - 28).
Quick Start Guide

Video Features

You can switch display devices, and configure display options, from the Display control panel (in Appearance and Personalization). Click Adjust resolution to make changes to the appearance of the display and to detect and configure any attached displays. In Windows 10 it is possible to quickly configure external displays from the Project menu (press the Windows logo key + on your keyboard and the P key).

To Configure Displays using Project

1. Attach your display to the appropriate port, and turn it on.
2. Press the + P key combination.
3. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen only.
4. You can also click Connect to a wireless display at the bottom of the Project screen and follow the steps to connect to any wireless enabled display.

NVIDIA Video Driver Controls

More detailed video controls are provided by the NVIDIA Control Panel (for more detailed information see Appendix C).

You can also access the control panel by right-clicking the desktop and selecting NVIDIA Control Panel (Figure 1 - 26 on page 1 - 36).

Figure 1 - 22 - Project (Devices)
To access Display (Control Panel) and Screen Resolution in *Windows*:

1. Go to the **Control Panel**.
2. Click **Display** (icon) and **Adjust Resolution** - In the **Appearance and Personalization** category.
3. Make and changes required from the **Display, Resolution, Orientation** or **Multiple display** menus.
4. Click **Apply** to save the settings.

![Screen Resolution Figure](image)

**Screen Resolution**

1. Use the dropbox to select the screen **Resolution** (Figure 1 - 23).
2. Click **Advanced settings** (Figure 1 - 23) to bring up the **Advanced** properties tabs.
3. Click **Apply** to save any changes made.
Quick Start Guide

Display Settings:
1. You can quickly adjust the display by right-clicking the desktop and selecting Display Settings ① (Figure 1 - 24).
2. Adjust the settings using the sliders in the menu or click Advanced display settings ② (Figure 1 - 24) to change resolution.
3. Click Apply to save any changes made to resolution.

Figure 1 - 24 - Display Settings
To access the Intel(R) HD Graphics Control Panel:
1. Click **Advanced settings** (Figure 1 - 23 on page 1 - 33) in the **Screen Resolution** control panel in Windows.
2. Click the Intel(R)... tab and click **Graphics Properties** (button) (Figure 1 - 25 on page 1 - 35).
**OR**
3. Right-click the desktop and select **Graphics Properties** from the menu.
**OR**
4. Click the icon in the notification area of the Desktop taskbar and select **Graphics Properties** from the menu.

*Figure 1 - 25 - Intel Graphics Control Panel*
Quick Start Guide

To access the *NVIDIA Control Panel*:
1. Right-click the desktop and select *NVIDIA Control Panel* (Figure 1 - 26).

   OR

2. Double-click the icon (Figure 1 - 26) in the *Windows* control panel.
Power Options

Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power button item in Start Menu (or the context menu) may be used to Shut down or Restart (you can also add Hibernate/Sleep to the menu - see page 1 - 38). To fully control all the power options (including Hibernate mode) go to the Power Options control panel and configure the power button, sleep button and lid to perform the function selected.

Using the Power Button
1. Go to the Start Menu.
2. Click the Power button.
3. Select the power state required from the menu.

Figure 1 - 27 - Shut Down/Restart
Quick Start Guide

You can also use the context menu (right-click the Start Menu icon or press the Windows logo + X key combination) to Sign out, Sleep, Hibernate, Shut down, and Restart.

Figure 1 - 28 - Context Menu Shut Down or sign out

Adding Hibernate/Sleep to the Power Menu

1. Go to the Power Options (Hardware and Sound) control panel.
2. Click Choose what the power buttons do.
3. Click “Change settings that are currently unavailable”.
4. Click to put a check in the Hibernate/Sleep box under Shutdown settings.
5. Click Save Changes and close the control panel.

Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination to bring up a full-screen displaying Lock, Sign out, Change a password, Task Manager and Switch User. If you click the Power icon in the lower right corner of the screen a power management option menu appears to display Sleep, Hibernate, Shut down, and Restart.

1 - 38 Power Options
Minimum Screen Resolution Settings
1. *Windows 10* has minimum screen resolution requirements.
2. Right-click a blank area of the Desktop and select *Screen Resolution* (or go to the *Display* control panel).
3. Adjust the *Resolution* to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above.

*Figure 1 - 29 - Screen Resolution*
Chapter 2: Storage Devices, Mouse, & Audio

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive/Solid State Drive
- Optical (CD/DVD) Device
- Multi-in-1 Card Reader
- Audio Features
- Touchpad and Buttons/Mouse
Hard Disk Drive/Solid State Drive

The hard disk drive (HDD) and/or solid state drive (SSD) is used to store your data in the computer. The hard disk can be taken out to accommodate other serial (SATA) hard disk drives (see “Storage” on page D - 2 for specification information), however you will need to contact your distributor/supplier to do this in order to avoid violating the terms of your warranty.

Bottom Cover Removal Warning
Do not remove any cover(s) and/or screw(s) for the purposes of device upgrade as this may violate the terms of your warranty.

If you need to replace/remove the hard disk for any reason, please contact your distributor/supplier for further information.
Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the module you purchased (see “Storage” on page D - 2). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 15).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the notification area to check the setting (see “Audio Features” on page 2 - 7).

Figure 2 - 1
Optical Device
Handling CDs or DVDs

Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.
DVD Regional Codes
To change the DVD regional codes:

1. Go to the Control Panel
2. Double-click Device Manager (Hardware and Sound > Devices and Printers), then click the arrow next to DVD/CD-ROM drives.
3. Double-click on the DVD-ROM device to bring up the Properties dialog box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code.
4. DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

- **Region 1** - USA & Canada
- **Region 2** - Western Europe, Japan, South Africa, Middle East & Egypt
- **Region 3** - South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong
- **Region 4** - South & Central America, Mexico, Australia, New Zealand
- **Region 5** - N Korea, Russia, Eastern Europe, India & Most of Africa
- **Region 6** - China

Figure 2 - 2
DVD Region Codes
Multi-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader driver (see “Card Reader” on page 4 - 7).

- MMC (MultiMedia Card) / RSMMC
- SD (Secure Digital) / Mini SD / SDHC / SDXC

Note: Some of these cards require PC adapters that are usually supplied with the cards.

Setup for Audio Recording
Audio Features

You can configure the audio options on your computer from the Sound control panel in Windows, or from the Realtek HD Audio Manager icon in the taskbar notification area/control panel (right-click the taskbar notification area icon to bring up an audio menu). The volume may also be adjusted by means of the volume icon in the taskbar or the audio slider in the Settings menu (see sidebar).

![Realtek Audio Manager]

Right-click the icon to access the menu above.

See “HDMI Audio Configuration” on page C - 9 for a description of the audio configuration when connecting an HDMI supported display device.
See “Sound Blaster Cinema 2” on page 6 - 19 for more information on the Sound Blaster Audio setup.
Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instructions below:

1. Go to the Control Panel.
2. Click Realtek HD Audio Manager (Hardware and Sound), or right-click the taskbar icon and select Sound Manager.
3. Click Microphone Effects (tab) in Microphone (tab), and then click to select Noise Suppression (button), or adjust the Recording Volume level to around 60, to obtain the optimum recording quality.
4. Click OK to close the control panel and save the settings.

Disabling Front Jack Detection
It is recommended that you do not disable front panel jack detection in Connector Settings.
Disabling front panel jack detection may cause your internal microphone to become disabled, and audio may continue to play through the system’s internal speakers even when headphones are plugged-in to the headphone jack (see page 7 - 9).

Sound Blaster Cinema 2 Audio
Note that you will need to install the Sound Blaster Cinema 2 audio application in order to get maximum audio performance. See “Sound Blaster Cinema 2” on page 6 - 13.
Touchpad and Buttons/Mouse

The Touchpad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The Touchpad buttons function in much the same way as a two-button mouse.

Touchpad Cleaning

In order to improve pad performance it is necessary to keep the surface clean and free of fingerprints and marks etc.

Use a soft dry cleaning cloth to keep the pad surface clean.

Disabling the Pad

Use the \texttt{Fn + F1} or Control Center button to disable the Touchpad.
Storage Devices, Mouse, & Audio

Touchpad Sensitivity
The mouse button zones at the bottom of the pad measure about 15mm from the bottom of the pad, and the left and right buttons are divided roughly down the middle as illustrated below. Press the left button zone for a left click, and right button zone for a right click action.

Mouse Driver
If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device’s user documentation for details.

Figure 2 - 7
Touchpad Sensitivity
Touchpad Configuration

Once you have installed the TouchPad driver (see “Touchpad” on page 4 - 8) you can configure the functions from the Mouse control panel in Windows, or by double-clicking the TouchPad driver icon in the notification area of the taskbar in the Desktop app. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information at www.synaptics.com.

TouchPad Scrolling
This computer model series may feature different TouchPad versions.
These TouchPads may differ in their vertical scrolling function in most scrollable windows.
Some TouchPads require sliding the finger up and down on the right of the TouchPad to scroll the window. Other versions require tapping/holding down the finger at the top right or bottom right of the TouchPad to scroll the window.

Figure 2 - 8
Mouse Properties
Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (action) on the surface of the Touchpad to perform specific actions to manipulate documents, objects, and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

1. Go to the Control Panel.
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.
Disabling the Touchpad

If you need to disable the Touchpad for any reason (e.g. you may find that when using the computer’s internal keyboard you accidentally trigger the Touchpad when resting your wrists or palms on it) you can do so by using \texttt{Fn + F1} key combination.

You can also set the system to automatically disable the internal Touchpad when an external USB point device (e.g. a USB mouse) is attached.

1. Go to the \textbf{Mouse Properties} control panel.
2. Click to select \textbf{Device Settings} (tab).
3. Click to place a check in the \textit{Disable internal pointing device when external USB pointing device is attached} check box.
4. Click \textbf{OK} to save the setting.

\textbf{Figure 2 - 10}
Mouse Properties (Disable Touchpad)
PalmCheck™

The PalmCheck™ feature (Device Settings > Settings > Pointing > Sensitivity) helps prevent operating the Clickpad/Touchpad by accident, by recognizing when your palm is resting on it or brushing its surface while you are typing.

In order to improve Clickpad/Touchpad scrolling responsiveness when using one-finger scrolling, you can adjust the PalmCheck™ slider towards “Minimum” as per your preference.

However bear in mind that adjusting the slider too far towards “Minimum” can turn off PalmCheck™ altogether.

Figure 2 - 11
PalmCheck™ Slider
Storage Devices, Mouse, & Audio

Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you to scroll horizontally and vertically. Place two fingers, slightly separated, on the TouchPad surface and slide both fingers in the direction required (in a straight continuous motion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel in Windows applications that support CTRL + scroll wheel zoom functionality. Place two fingers on the TouchPad (for best results use the tips of the fingers) and slide them apart to zoom in, or closer together to zoom out.

Figure 2 - 12
Scrolling Gesture

Figure 2 - 13
Zooming Gesture
Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments. Place a finger down on the left “target” zone and keep it stationary. Place another finger near the middle of the TouchPad and slide it in a circular motion around the stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of applications such as browsing the Internet or scrolling through a photo viewer. The Three Fingers Down gesture may be used to launch user-selectable applications.
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system. This chapter covers:

- The Power Sources
- Turning On the Computer
- Power Plans
- Power-Saving States
- Configuring the Power Buttons
- Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter (make sure you use the adapter when first setting up the computer, as to safeguard the computer during shipping, the battery will be locked to not power the system until first connected to the AC/DC adapter).
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “Battery FAQ” on page 3 - 21).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 17.
Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options (Hardware and Sound) in the Windows control panel to configure this feature.

> **Power Button as Stand by or Hibernate Button**

You can use the OS's "Power Options" control panel to set the power button to send the system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring the Power Buttons” on page 3 - 9 for details).
Shutting the Computer Down

Note that you should always shut your computer down by choosing the **Shut down** command as this will help prevent hard disk or system problems. Use the **Power** item in the **Start Menu** and select **Shut down**.

You can also use the **context menu** (right-click the Start Menu icon or press the Windows logo + X key combination) to **Sign out, Sleep, Hibernate, Shut down**, and **Restart**.

If you want to add Hibernate/Sleep to the Power Menu see “**Adding Hibernate/Sleep to the Power Menu**” on page 3 - 10.
Power Plans

The computer can be configured to conserve power by means of power plans (Control Panel > Power Options). You can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.

Resuming Operation

See Table 3 - 1, on page 3 - 11 for information on how to resume from a power-saving state.

Password

It is recommended that you enable a password on system resume in order to protect your data.
Power Management

Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** (you may need to click *Show additional plans* to view the High performance plan) for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.

*Figure 3 - 3*  
Power Plans

Click to Show/Hide additional power plans
Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. *Windows 10* uses the Sleep, Hibernate and Shut Down power-saving states.

**Sleep**

In Sleep all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in Sleep is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.
Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery. To add Hibernate to the Power Menu see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down

You should Shut down the computer if you plan to install new hardware, plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from Shut down takes longer than from Sleep or Hibernate.

Figure 3 - 4
Power Button & Start Menu Power
Configuring the Power Buttons

The power/sleep button (Fn + F12 key combo) and closed lid may be set to send the computer into a power-saving state. Click Choose what the power buttons do on the left menu in Power Options to bring up the menu.

Password Protection

It is recommended that you enable a password on wake up in order to protect your data. However, you can disable this setting from the Power Options menu by clicking Require a password on wakeup in the left menu, and selecting the options (click Change settings that are currently unavailable).

Figure 3 - 5
Power Options
Define Power Buttons
Adding Hibernate/Sleep to the Power Menu

Add Hibernate/Sleep to the Power Menu as follows.

1. Go to the Power Options (Hardware and Sound) control panel (see page 1 - 36).
2. Click “Change settings that are currently unavailable”.
3. Click Choose what the power buttons do.
4. Click to put a check in the Hibernate/Sleep box under Shutdown settings.
5. Click Save Changes and close the control panel.
Resuming Operation

You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button (Fn + F12 key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td>Press the Power Button</td>
<td></td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td>Press the Power Button Press the Sleep Button (Fn + F12 Key Combo)</td>
<td></td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery)</td>
<td>Press the Power Button</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Orange (AC/DC adapter)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td>Press a Key or Move the Mouse/Touchpad</td>
<td></td>
</tr>
</tbody>
</table>

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down hot key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down).

Closing the Lid

If you have chosen to send the computer to Sleep when the lid is closed, raising the lid will wake the system up.
Power Management

3 - 12 Configuring the Power Buttons

Power Conservation Modes
This system supports Power Saving power management features that place computers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period of inactivity. Adjust Power Conservation Modes from the Control Center:

1. Press the Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Power Saving button.

Figure 3 - 7
Control Center

Note that the Energy Star setting will put the display into sleep after no more than 15 minutes of user inactivity.

Power Conservation Modes
The Power Saving setting will result in maximum power saving, but with the possible loss of some performance.
Setting the mode to Balance will give power saving matched with performance.
Performance will give optimum computer performance but with less power conservation.
Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination from almost any of the Windows 10 interfaces/Apps to bring up a full-screen displaying Lock, Switch User, Sign out, Change a password and Task Manager options. If you click the Power icon in the lower right corner of the screen a power management option menu appears to display Sleep, Shut down, and Restart.

To fully control all the power options (including Hibernate mode) go to the Power Options control panel and configure the power button, sleep button and lid to perform the function selected.

Figure 3 - 8
Ctrl + Alt + Delete Menu
Power Management

Settings Menu Power Controls

The Settings item in the Start Menu (and also as an App) gives you access to a number of power settings control panels which enable you to quickly adjust power options. Click System to access the menu including the power option settings.

![Figure 3 - 9 Settings](image-url)
Battery Saver
Battery Saver will display the battery level, and by clicking **Battery Use** you can see the current state of battery usage by application etc. Click **Battery saver settings** to adjust the battery saver level.

![Figure 3 - 10](image)

**Settings > Battery Saver**
Power Management

Power & Sleep
Power & sleep gives you quick access to Screen and Sleep settings. Click Additional power settings to go to the main power options control panel.

Figure 3 - 11
Settings > Power & Sleep

Related settings
Additional power settings
Battery Information

Follow these simple guidelines to get the best use out of your battery.

**Battery Power**

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan **Change plan settings > Change advanced power settings** (see Figure 3 - 3 on page 3 - 6).

Click the battery icon in the notification area to see the current battery level and charge status (you can also click **Power & sleep settings** to access the Settings menu to quickly adjust power settings).

---

**Low Battery Warning**

When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.

---

**Figure 3 - 12**

Battery Icon (Notification Area) & Battery Advanced Settings
Conserving Battery Power

- Use a power plan that conserves power (e.g. Power saver), however note that this may have an affect on computer performance.
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Reduce the amount of time before the display is turned off.
- Close wireless, Bluetooth, modem or communication applications when they are not being used.
- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

Figure 3 - 13
Windows Mobility Center (Control Panel)
Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We should not remove the built-in battery yourself (see sidebar).

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 21 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. Refer to “LED Indicators” on page 1 - 8 for information on the battery charge status, and to “Battery FAQ” on page 3 - 21 for more information on how to maintain and properly recharge the battery pack.
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

**Caution**

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.

**Damaged Battery Warning**

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your distributor/supplier. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
Power Management

3. Click *Change plan settings* (after creating it) and click *Change plan settings > Change advanced power settings*.

*Figure 3 - 15*
Change Plan Settings / Change Advanced Power Settings
4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 1%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing

![Figure 3 - 16 Power Options Advanced Settings - Battery](image)
Power Management

**How do I fully charge the battery?**
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

**How do I maintain the battery?**
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

What to Install

You will need to attach an external optical CD/DVD device drive to install the drivers from the Device Drivers & Utilities + User’s Manual disc. The disc contains the drivers and utilities necessary for the proper operation of the computer. **Table 4 - 1, on page 4 - 4** lists what you need to install and **it is very important that the drivers are installed by the method outlined in this chapter, and in the order indicated**. Note that the information on the following pages is for **Windows 10 (64-bit) only**.

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, Bluetooth & WLAN Combo, Intel Technology, Sound Blaster Cinema and 4G modules are provided in “Modules” on page 6 - 1.
Drivers & Utilities

Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.
4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1
5. Check the driver installation order from *Table 4 - 1, on page 4 - 4* (the drivers must be installed in this order) which is the same as that listed in the *Drivers Installer* menu below.
6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the following pages.

*Figure 4 - 2 - Install Drivers*
### Drivers & Utilities

<table>
<thead>
<tr>
<th>Win 10 (64-bit)</th>
<th>Page #</th>
<th>Win 10 (64-bit) - Optional Items</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page 4 - 7</td>
<td>Wireless LAN Module</td>
<td>Page 6 - 2</td>
</tr>
<tr>
<td>Video (VGA)</td>
<td>Page 4 - 7</td>
<td>Fingerprint Reader Module</td>
<td>Page 6 - 8</td>
</tr>
<tr>
<td>NVIDIA Video (VGA)</td>
<td>Page 4 - 7</td>
<td>Bluetooth &amp; WLAN Combo Module</td>
<td>Page 6 - 12</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 7</td>
<td>Intel® Rapid Storage Technology (required for hard disks in AHCI &amp; mode)</td>
<td>Page 6 - 18</td>
</tr>
<tr>
<td>Card Reader</td>
<td>Page 4 - 7</td>
<td>Sound Blaster Cinema 2</td>
<td>Page 6 - 19</td>
</tr>
<tr>
<td>Touchpad</td>
<td>Page 4 - 8</td>
<td>PC Camera (no driver installation required)</td>
<td>Page 6 - 29</td>
</tr>
<tr>
<td>Airplane</td>
<td>Page 4 - 8</td>
<td>Trusted Platform Module (no driver installation required)</td>
<td>Page 6 - 34</td>
</tr>
<tr>
<td>Control Center</td>
<td>Page 4 - 8</td>
<td>3G/4G Module (Models A &amp; B Only - no driver installation required)</td>
<td>Page 6 - 40</td>
</tr>
<tr>
<td>MEI Driver</td>
<td>Page 4 - 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 8</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

All drivers provided are for the Windows 10 (64-bit) operating system.

Table 4 - 1 - Driver Installation

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.

---

4 - 4 Driver Installation
Manual Driver Installation
Click *Browse CD/DVD* (button) in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable *Check for updates* (*Settings > Update & security > Check for updates*) in order to get all the latest security updates etc. (all updates will include the latest hot-fixes from Microsoft). See “*Windows Update*” on page 4 - 9 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the *Control Panel* in the *Windows OS* and double-click the *Programs* icon (*Programs > Uninstall a program*). Click to select the driver (if it is not listed see below) and click *Uninstall*, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the *Programs and Features* menu:

1. Go to the *Control Panel*.
2. Double-click *Device Manager* (*Hardware and Sound > Devices and Printers > Device Manager*).
3. Double-click the *device* you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click *Driver* (tab) and click the *Update Driver* or *Uninstall* button and follow the on screen prompts.
User Account Control
If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or “Install” to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.

Driver Installation General Guidelines
The driver installation procedure outlined in this Chapter (and in Chapter 7 Options & Modules), are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish) unless you are an advanced user. In many cases a restart is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are ON (i.e. the system is not in Airplane Mode) before installing the appropriate driver.
Driver Installation Procedure

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).

**Chipset**
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Accept > Install.
3. Click Restart Now to restart the computer.

**Video (VGA)**
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

**NVIDIA Video (VGA)**
1. Click 3.Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the license agreement.
3. Click Next.
4. Click the Close button to complete the installation.

**LAN**

*Note:* After installing the video driver go to the Display control panel to adjust the video settings to the highest resolution.

**LAN**

*Note:* If the computer enters a deep sleep mode during installation, you will be prompted to plug in a network cable, and click OK, to continue installation. If a network cable is not available, restart the system and reinstall the LAN driver.

1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

**Card Reader**

1. Click 5.Install Cardreader Driver > Yes.
2. Click Finish.
**Drivers & Utilities**

**Touchpad**
1. Click **6.Install Touchpad Driver > Yes.**
2. Click **Next.**
3. Click the button to accept the license, and then click **Next.**
4. Click **Finish > Restart Now** to restart the computer.

**Airplane**
*Note: Do not use Update Driver in Device Manager to install the Airplane Mode driver.*
1. Click **7.Install Airplane Driver > Yes.**
2. Click **Next > Install.**
3. Click **Finish** to restart the computer.

**Control Center**
1. Click **8.Install Control Center AP > Yes.**
2. Click **Next > Install.**
3. Click **Finish** to restart your computer (see **Appendix B**).

**MEI Driver**
1. Click **9.Install MEI Driver > Yes.**
2. Click **Next.**
3. Click the check box to accept the license and then click **Next.**
4. Click **Next.**
5. Click **Finish.**

**Audio**
1. Click **10.Install Audio Driver > Yes.**
2. Click **Next.**
3. Click **Finish** to restart the computer.

Note that after installing the audio driver the system will not return to the *Drivers Installer* screen. To install any of the optional drivers listed overleaf, eject the *Device Drivers & Utilities + User’s Manual* disc and then reinser it (or double-click the disc icon in *My Computer*), and click **Option Drivers** (button) to access the optional driver menu.

(See Overleaf)
It is recommended that you install the Sound Blaster Audio application (see “Sound Blaster Cinema 2” on page 6 - 19) and Intel Rapid Storage Technology driver (see “Intel® Rapid Storage Technology” on page 6 - 18 - required for AHCI & RAID mode).

Windows Update

After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft).

To enable Windows Update make sure you are connected to the internet:

1. Go to the Control Panel.
2. Click Windows Update (System and Security/Security).
3. Click Check for updates (button).
4. The computer will now check for updates (you need to be connected to the internet).
5. Click Install now (button) to begin checking for the updates.
6. Click Install updates (button) to install the updates.
Drivers & Utilities

Optional Drivers
See the pages indicated in *Table 4 - 1, on page 4 - 4* for the driver installation procedures for any modules included in your purchase option.

*Figure 4 - 3 - Optional Drivers Installer Screen*

*Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.*
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

**Diagnostics:** The POST (Power-On Self Test)

**Configuration:** The *Setup* utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in *Setup*. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing.* Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.
The Power-On Self Test (POST)

If you enable the **Boot-time Diagnostic Screen** in the Setup Utility, each time you turn on the computer the system takes a few seconds to conduct a **POST**, including a quick test of the on-board RAM (memory).

As the **POST** proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run **Setup**.

If there are no problems, the **Setup** prompt will disappear and the system will load the operating system. Once that starts, you can’t get into **Setup** without rebooting.

---

**Warning**

Incorrect settings can cause your system to malfunction. To correct mistakes, return to **Setup** and restore the **Optimized Defaults** with <F3>.

**UEFI Boot & POST**

When UEFI Boot is enabled, then the prompts to press F2 or F7 will not appear. However you can still press F2 to enter the setup, or F7 to choose the preferred boot device, if you press the key immediately the system boots up.
**Failing the POST**

Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

**Fatal Errors**

These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized distributor/supplier as soon as possible.

**Non-Fatal Errors**

This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) and you can then press F7 (the F7 on screen will be highlighted to illustrate that the system is processing the request) for boot options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be highlighted to illustrate that the system is processing the request) to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Utility

The **Aptio Setup Utility** tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

**Entering Setup**

To enter *Setup*, turn on the computer and press **F2** (give the system a few seconds to enter *Setup*; the **F2** on screen will be highlighted to illustrate that the system is processing the request) during the **POST** (or press **F7** for boot options). If you get a “Keyboard Error”, (usually because you pressed **F2** too quickly) just press **F2** again.

If the computer is already on, reboot using the **Ctrl + Alt + Delete** combination and then hold down **F2** when prompted. The *Setup* main menu will appear.

To see the boot options press **F7**.
Setup Screens
The following pages contain additional advice on portions of the Setup. Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of the screen.

If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the upper right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
Main Menu

*Figure 5 - 2 Main Menu*

**System Time & Date (Main Menu)**

The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
**SATA Port # (Main Menu)**
Pressing **Enter** opens the sub-menu to show the configuration of a optical Device/HDD on the computer’s SATA Ports.

**OffBoard SATA Controller Configuration (Main Menu)**
Pressing **Enter** opens the sub-menu to show the configuration of any devices on the off board SATA Controller if applicable.

**ME FW Version/System/Extended Memory (Main Menu)**
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

**MB Series/BIOS Revision/KBC/EC firmware Revision/Mac Address (Main Menu)**
This item contains information on the BIOS version, and the identifier address for the device on a network, and is not user configurable.
**Intel(R) Rapid Start Technology (Advanced Menu)**

Enable/disable **FlexiCharger** or **GPU Performance Scaling** from this menu. The rapid start hibernation mode can resume power within seconds and can remember your computer's state with zero power.
**GPU Performance Scaling (Advanced Menu > Advanced Chipset Control)**
You can enable/disable NVIDIA GPU Performance scaling from this menu. The NVIDIA Card does the scaling if this option is on, and has less latency than the Intel GPU. This can be useful if you play games etc.

**FlexiCharger (Advanced Menu > Advanced Chipset Control)**
The sub-menu here allows you to enable/disable the FlexiCharger. The FlexiCharger may be set to automatically start charging your battery when the battery reaches a certain capacity level (e.g. you could start the battery charge level at 40%).

See the sidebar warning for information on running the FlexiCharger for an extended period as this is not recommended.

---

- **Warning:** If you leave the FlexiCharger continuously "Enabled" for a period of three months or more, the battery meter's reading accuracy will deteriorate.

  To reset this, set the FlexiCharger to "Disabled", and then allow the battery to completely discharge (see “Battery FAQ” on page 3 - 21) before enabling the function again.

---

**Figure 5 - 4**
Advanced Chipset Control > FlexiCharger
**SATA Mode (Advanced Menu)**
The SATA (Serial ATA) controller operates in **AHCI** (Advanced Host Controller Interface) mode. Install the **Intel Rapid Storage Technology** driver to support your drive in AHCI mode (see “Intel® Rapid Storage Technology” on page 6 - 18).

**Boot Logo (Advanced Menu)**
Use this menu item to enable/disable the **Boot Logo** screen at system startup **if you have not enabled UEFI Boot**. If you disable the **Boot Logo** you will not see the **F2 Enter Setup** or **F7 Boot Options** prompts on the screen, however you can still press these keys, while the boot screen is displayed, to perform the Enter Setup or Boot Option functions.

**Power On Boot Beep (Advanced Menu)**
Use this menu item to enable/disable the beep as the computer starts up.

**Battery Low Alarm Beep (Advanced Menu)**
Use this menu item to enable/disable the battery low alarm beep.
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect access to the computer OS (only the Aptio Setup Utility).
Note: To clear existing passwords press **Enter** and type the existing password, then press **Enter** for the new password (without typing any password entry) and **Enter** again to confirm the password clearance.

**Note:** You can only set the user password after you have set the supervisor password.

**Set User Password (Security Menu)**
You can set a password for user mode access to the Aptio Setup Utility. This will not affect access to the computer OS, (only the **Setup** utility) unless you choose to set a **Password on Boot** (see below). Many menu items in the Aptio Setup Utility cannot be modified in user mode.

**Note:** You can only set the user password after you have set the supervisor password.

**Password on boot: (Security Menu)**
Specify whether or not a password should be entered to boot the computer (you may only set a password on boot if a supervisor password is enabled). If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled.”
Secure Boot Control (Security Menu)
Secure Boot Control prevents unauthorized operating systems and software from loading during the startup process. **Secure Boot** is available as a menu option if you have enabled **UEFI Boot** (see “Boot Menu” on page 5 - 15). Enabling Secure Boot will bring up the **Secure Boot Mode** menu to enable you to configure Secure Boot as **Standard** (with a fixed secure boot policy), or **Custom** (which enables you to make changes to the **Key Management** database).

![Figure 5 - 6 Security - Secure Boot (Key Management)](image)
**TPM Configuration (Security Menu)**

This sub-menu will allow you to enable/disable Trusted Platform Module (TPM) support, and to configure the TPM State. Select **TPM Configuration** and press Enter to access the sub-menu. Press Enter to access the **Security Device Support** menu and select **Enable** to support TPM. You can select **Pending operation**, and then select **TPM clear** to clear existing TPM information in order to reset the TPM (see “Trusted Platform Module” on page 6 - 34 for details).

---

**Figure 5 - 7**

**Security Device Support**
Boot Menu

When you turn the computer on it will look for an operating system (e.g. *Windows 7*) from the devices listed in this menu, and **in this priority order**. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the **Boot Option Priorities**.

**Figure 5 - 8**

*Boot Menu*

**BIOS Screens**

Note that the BIOS screens pictured on these pages are intended for guidance in setting up your system’s BIOS. BIOS versions are subject to constant change and revision, therefore your computer’s actual screens may appear slightly different from those pictured on these pages.
**Boot Option Priorities (Boot Menu)**
Press Enter to select the Boot Option # and use the arrow keys to select any device in order to move its boot priority up and down the list (the selected device will be highlighted in white).

**UEFI Boot (Boot Menu)**
Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Interface (UEFI) specification provides a clean interface between operating systems and platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard boot and runtime services. The *Network Stack* item will be enabled as an option under UEFI Boot.

**Launch CSM (Boot Menu)**
Launching CSM allows for traditional operating systems, which do not support UEFI, to load. **Do not Enable this item for Windows 10 operating systems.**
Click **Save Changes and Reset** to save all changes made. Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Modules

Overview

This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• Wireless LAN Module
• Fingerprint Reader Module
• Bluetooth & WLAN Combo Module
• Intel® Rapid Storage Technology
• Sound Blaster Cinema 2
• PC Camera
• Trusted Platform Module
• 3G/4G Module
Wireless LAN Module

If you have included an Intel®, 3rd Party 802.11b/g/n or Qualcomm Atheros (Combo) module is on (i.e. the system is not in Airplane Mode) before installing the driver.

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 4.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.

See the appropriate driver installation instructions on the page indicated below:

- See “3rd Party 802.11b/g/n Driver Installation” on page 6 - 3.
- See “Intel® WLAN Driver Installation” on page 6 - 3.
- See “Qualcomm Atheros WLAN Combo Driver Installation” on page 6 - 4.
3rd Party 802.11b/g/n Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in Windows (see page 6 - 5).

Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the check box to agree to the End User License Agreement and click Install.
5. Click Finish.
6. The operating system is the default setting for Wireless LAN control in Windows (see page 6 - 5).
Qualcomm Atheros WLAN Combo Driver Installation

1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Select the language preferred and click Next.
5. Click Next > Next.
6. Click in the check box to accept to the License Agreement and click Next.
7. Click Finish.
8. Click Yes to restart the computer.
9. The operating system is the default setting for Wireless LAN control in Windows (see page 6 - 5).
WLAN Configuration in Windows 10
You can configure a wireless connection using one of the following options, however make sure the Wireless LAN module is turned on (and not in Airplane Mode) before configuration begins.

1. Click the Wireless icon in the notification area of the taskbar.
2. Make sure that Airplane mode is off (the Airplane mode icon should be gray).
3. A list of available access points will appear.
4. Double-click an access point to connect to it (or click it and click Connect).

![Figure 6 - 1 WiFi & Network Connections](image_url)
5. Enter a network security key (password) if required, and click Next.
6. You can choose to share or connect to devices or not.
7. When you are connected to the network access point it will display **Connected** status.
8. Select any connected network and click **Disconnect** to disconnect from a connected access point.

**Figure 6 - 2**
Network Connected (Click Disconnect)

**Wireless Device Operation Aboard Aircraft**

The use of any portable electronic transmission devices aboard aircraft is usually prohibited.

Make sure the module is either **OFF** or in **Airplane mode** if you are using the computer aboard aircraft.
9. You can click the **Airplane Mode** button to turn the mode On or Off.

10. You need to either use **Airplane Mode**, or to turn the **WLAN module off** aboard the aircraft.

11. If you click on **Network Settings** to bring up **Network & Internet** for a more comprehensive list of network and internet settings including **Wi-Fi** (can be turned on/off), **Airplane mode** (Airplane mode and Wireless devices can be turned on/off) **VPN**, **Dial-up**, **Ethernet** and **Proxy**.

12. You can also access the **Network & Internet** settings from the **Start Menu** (Settings > Network & Internet).
Fingerprint Reader Module

The fingerprint reader module provides a high level of security for your computer. Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

There are two different fingerprint modules supplied with this model. Install the driver from the Device Drivers & Utilities + User’s Manual disc by following the appropriate instructions on the page overleaf.

The fingerprint reader module uses the Sign-in options configuration of the Windows Account.

Fingerprint Reader and Power Saving States

If your computer is in a power saving state (e.g. Hibernate or Sleep) you should keep your finger clear of the fingerprint sensor.

Allow the system to fully resume before swiping your finger across the sensor.
Fingerprint Reader Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the DVD drive.
2. Click *Option Drivers*.
3. Click *2.Install Fingerprint Driver > Yes*.
4. Click *Next > Install*.
5. Click *Finish* to complete the installation.
6. The fingerprint reader module uses the **Sign-in options** configuration of the *Windows Account* (see overleaf).
Fingerprint Module Configuration
1. Click the Settings item in the Start Menu and then click Accounts and click Sign-in options.
2. You will need to add a Windows password (click Add under Password).
3. After you have added the password you will need to also add a PIN.
4. Under Windows Hello click Set up under Fingerprint.
5. The wizard will then guide you through the set up process to scan your fingerprints.

Figure 6 - 4
Accounts - Sign-in options
(Add Fingerprint)
6. You will be instructed to **swipe the same finger** across the reader a number of times.
7. Click **Close** when complete.
8. You can choose to **Add another** finger (this is recommended) or **Remove** the current fingerprint reading.
9. You can now scan your fingerprint to log-on to the computer.
Bluetooth & WLAN Combo Module

If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel®, Qualcomm Atheros or 3rd Party module) then install the driver as instructed on the following pages.

Make sure that the module is on (i.e. the system is not in Airplane Mode) before installing the driver.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.
3rd Party Bluetooth (V4.0) Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.

Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click in the check box to accept the license and click Next.
6. Select the setup type (Typical is recommended) and click Install.
7. Click Finish.
Qualcomm Atheros Bluetooth Combo Driver Installation

1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 3. Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click Install.
6. Click Finish.
7. Click Yes to restart the computer.
Bluetooth Configuration in Windows
1. Click the Settings item in the Start Menu and then click Devices (or click the Bluetooth icon in the taskbar and click Add a Bluetooth Device).
2. Click Bluetooth and make sure Bluetooth is On and a list of discovered devices will appear.
3. Double-click the device you want to pair with the computer and click Pair.
4. On first connection the computer will provide you with a pairing code to be entered onto the device.
5. Enter the code into your Bluetooth enabled device and click Yes on the computer to complete the pairing.
6. Select a device and click **Remove Device** to disconnect from any device.

*Figure 6 - 7*

**Devices > Bluetooth**

Remove Device
To Make your Computer Discoverable to Bluetooth Devices

1. Click the **Settings** item in the Start Menu and then click **Devices**.
2. Click **Bluetooth** and under **Related Settings** click **More Bluetooth options** (or click the Bluetooth icon in the taskbar **Open Settings**).
3. In **Bluetooth Settings** make sure that **Allow Bluetooth devices to find this PC** check box (**Discovery**) has a check inside it.
4. Make sure that the **Alert me when a new Bluetooth device wants to connect** check box (**Notifications**) has a check inside it, if you want to be notified when a Bluetooth device wants to connect.

**Figure 6 - 8**
Bluetooth Settings
Intel® Rapid Storage Technology

Install the Intel® Rapid Storage Technology to support your AHCI mode SATA drive.

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install IRST Driver > Yes.
4. Click Next.
5. Click the check box to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.
8. Run the Intel® Rapid Storage Technology app from the Apps screen.
Sound Blaster Cinema 2

Install the Sound Blaster Cinema 2 application to allow you to configure the audio settings to your requirements for the best performance in games, music and movies.

Sound Blaster Cinema 2 Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install SBCinema AP > Yes.
4. Choose the setup language and click Next.
5. Click Yes to accept the license.
6. Click Next > Full Installation (button).
7. Click Next > Finish to restart the computer.
Sound Blaster Cinema 2 Application

Run the **Sound Blaster Cinema 2** control panel from the notification area of the taskbar (or from **Creative** folder item in the Apps menu). Click on the tabs to access any of the control panel menus.

*Figure 6 - 9*
**Sound Blaster Cinema 2 Apps Menu & Taskbar Icon**
Sound Blaster Cinema 2 Tutorial

The Sound Blaster Cinema 2 application will provide a quick Tutorial on the initial run of the application, however you can also run the Tutorial from the drop-down menu if you require a further introduction to the application.

Software Update

Check for the latest software updates by making sure you are connected to the internet and clicking Software Update from the drop-down menu. Follow the instructions provided to update the software.

Figure 6 - 10
Sound Blaster Cinema 2 Access Tutorial
modules

sound blaster cinema 2 advanced settings
sound blaster cinema 2 selects the built-in speakers by default and this setting may cause some sound quality issues when using headphones. to adjust the settings for headphones do the following:

1. run the sound blaster cinema 2 application.
2. click the advanced settings icon .
3. select headphones from the drop-down menu (you can adjust the slider for crossover frequency and test to hear the effect chosen).
4. click exit and close the application (or click the icon again to exit).

figure 6 - 11
sound blaster cinema 2 select headphones
The Sound Blaster Cinema 2 SBX PRO Studio (see overleaf) can be turned On/Off by clicking the Power Button (when the power is off the icon will be dimmed).

Volume can be adjusted by means of the slider to the right of the volume icon, and you can toggle mute on/off by clicking the volume icon itself ( / ).

Figure 6 - 12
Sound Blaster Cinema 2 Power & Volume
Sound Blaster Cinema 2 SBX Pro Studio

The Sound Blaster Cinema 2 SBX Pro Studio offers a suite of playback technologies to enhance sound. Each playback technology at the bottom of the screen has an On/Off button to allow you to enable/disable it, and most controls feature a slider to adjust the levels.

- **Surround**: Provides virtual sound channels to control the level of immersion.
• **Crystalizer:** Enriches audio to make it sound livelier.

• **Bass:** Enhances the bass level of the sound system.
Modules

- **Smart Volume**: Minimizes sudden volume changes to avoid the need for constant adjustment.

*Figure 6-16*
Sound Blaster Cinema 2 SBX Pro Studio
Smart Volume

- **Dialog Plus**: Optimizes dialogue levels for movies etc.

*Figure 6-17*
Sound Blaster Cinema 2 SBX Pro Studio
Dialog Plus

6 - 26 Sound Blaster Cinema 2
Sound Blaster Cinema 2 Profiles
The Profile buttons on the left side of the screen give you preset settings to enhance your audio settings for Music, Movie, Game and Voice. You can choose Custom to adjust the settings to your own set preferences.
**Sound Blaster Cinema 2 & HDMI**

1. When you connect an HDMI display to the HDMI-Out port, the Sound Blaster Cinema controls will be disabled.
2. A warning box will pop-up and will prompt “…Do you want to select another audio device now?”.
3. Click No to continue using the HDMI audio output from your external display (do not attempt to select another audio device when connected to the external HDMI display).

![Sound Blaster Cinema 2 HDMI Display Warning](image)
PC Camera

Use the **Fn + F10** key combination (see “Function Keys & Visual Indicators” on page 1 - 16) or Control Center button to toggle power to the PC Camera module.

When the PC Camera is in use the LED indicator to the left of the camera will be illuminated in red (see Figure 1 - 2 on page 1 - 7/Figure 1 - 3 on page 1 - 8/ Figure 1 - 4 on page 1 - 9).

Note that you need to use the Camera app in **Windows** to take pictures and capture video.
Camera App

1. Make sure the PC Camera is turned on by using the **Fn + F10** key combination (or **Control Center button**).
2. Run the Camera app from the Start menu by clicking on the **Camera app** icon (you can type “camera” into the search box to find the Camera app if it is not pinned to the Start menu).
3. The interface displays two buttons on the right of the screen; one for photo and one for video.
4. Simply click on the appropriate button to switch to either photo or video modes.
5. You can use the buttons at the top to access the **Photo** collection, **Self Timer** or **Settings**.

---

**Figure 6 - 20**
Camera App Mode Icons

---

**Figure 6 - 21**
Camera Menu Bar
6. Click **Settings** to access the camera settings menu to make adjustments for **Camera Button** long key press function, **Photo Aspect ratio**, **Framing grid**, video **recording frame rates**, **Flicker reduction** and **Digital video stabilization**.

---

**Camera Settings**

The **Self Timer** may be set to take Photos after 2, 5 or 10 seconds and can also be set to continue taking pictures until the camera button is pressed again.

The **Aspect Ratio** can be changed to those supported by the system.

You can use a **Framing grid** to help you line up pictures.

The **Video recording** resolution and frame rate can be set to any supported by the system. Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to File Explorer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

If you need to reduce any screen flicker, change the settings in **Flicker reduction** to either e.g. 50Hz or 60Hz.
Taking Pictures/Capturing Video

1. Make sure the PC Camera is turned on by using the **Fn + F10** key combination (or **Control Center button**).
2. Run the Camera app from the Start menu by clicking on the **Camera app** icon (you can type “camera” into the search box to find the Camera app if it is not pinned to the Start menu).
3. Click to select either **photo** or **video** modes.
4. Click the photo icon to take a picture, and the camera icon will briefly turn yellow as the picture is taken.
5. Click on the video icon to start video capture (if video capture begins a timer will appear at the bottom of the screen and the icon will turn yellow).
6. To stop video capture click the video icon again.

*Figure 6 - 23
Video Camera Recording in Process*
7. Captured photos and videos will be saved to the **Photos** app stored in the Start menu (type **Photos** into the search box if you cannot find the app).

*Figure 6-24: Photo App (For Captured Photos & Videos)*
Trusted Platform Module

(Optional)

The TPM security chip allows you to create and manage digital certificates for user and platform authentication. This type of security is usually administered within large enterprises and organizations, and therefore requires implementation by a system administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection. In addition Make sure you prepare a removable media (e.g. a USB flash drive) to store passwords etc. before beginning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
Enabling & Managing TPM
1. Restart the computer.
2. Enter the **Aptio Setup Utility** pressing **F2** during the POST/startup.
3. Use the arrow keys to select the **Security** menu.
4. Select **TPM Configuration** and press Enter to access the sub-menu.
5. Press Enter to access the **Security Device Support** menu and select **Enable**.
6. Press **F4** to save the changes and restart the computer.
7. You can now manage the TPM from **Windows**.

---

**Clearing TPM Information**

You can select **Pending operation**, and then select **TPM clear** to clear existing TPM information in order to reset the TPM.

---

**Figure 6 - 25**

TPM State (Enable)
TPM Management in Windows
You can manage your TPM settings from within Windows:

1. Go to the Control Panel.
2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.

Figure 6 - 26
BitLocker Drive Encryption (TPM Administration)
4. The TPM Management window allows you to configure the TPM within Windows. As TPM is usually administered within large enterprises and organizations, your system administrator will need to assist you in managing the information here.
TPM Actions

1. Click **Prepare the TPM** and follow the instructions in the Wizard to prepare the TPM (this will probably require a restart of the computer and confirmation of the setting changes after restart by pressing the appropriate F key).
2. After the restart the TPM will be prepared and you can then use the **Actions** menu to **Turn TPM off**, **Change Owner Password**, **Clear TPM** or **Reset TPM Lockout**.
3. A wizard will help take you through any setup steps.

*Figure 6 - 28
TPM Actions Menu*
BitLocker
BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt data on the disk. Access the Microsoft BitLocker Drive Encryption control panel applet from the Windows control panel (System and Security).

1. Click Turn on Bit Locker.
2. Follow the on-screen instructions to setup BitLocker, and make sure you have a removable media (e.g. a USB flash drive) to store saved recovery keys etc.
3G/4G Module
(For Model A & B Computers Only)
If you have included an optional UMTS/HSPA+ based 3G Module (Universal Mobile Telecommunications System or High Speed Packet Access) module or LTE (Long Term Evolution) 4G module (see “Communication” on page D - 3 for specification details) in your purchase option, you do not require a driver/application installation for Windows 8.1. Follow the instructions overleaf to install the USIM card (which will be provided by your service provider), and then use the Charms Bar Wireless icon to access the 3G/4G network in the same manner as the WLAN.

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appropriate antennas will be installed. Note that in order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in conjunction with any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules
In order to comply with FCC regulations you should NOT operate the 3G/4G module and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and cause interference. When the 3G/4G module is powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.
3G/4G Module USIM Card Installation
(For Model A & B Computers Only)
Insert the USIM card 1 as illustrated below (pay careful attention to the orientation of the card as the gold contact side of the card should face downwards) until it clicks fully into position. To eject the card simply press it until it ejects, but do not attempt to eject the card while connected to a 3G/4G network (see below).

Note that the USIM card’s readable side (with the gold-colored contacts) should face downwards as illustrated.

Figure 6 - 30
USIM Card Insertion

Simply press on the USIM card to eject it, however do not do this while a connection is in progress. If you do eject the card while a 3G/4G connection is ongoing, you will need to shut down the system, reinsert the USIM card, restart the system and then reestablish the 3G/4G connection.

If you wish to change USIM cards then you will need to shut the system down, reinsert the USIM card, restart the system and then reestablish the 3G/4G connection.

Model A

Note that only Model A is pictured, however the card insertion procedure for Model B is identical. Model C computers do not support a 3G/4G module.
3G/4G Configuration in Windows 10

You can configure a 3G/4G connection as below, however make sure the system is not in Airplane Mode before configuration begins. You can connect to a 3G/4G connection in much the same way as the WLAN connection.

1. Click the Settings item in the Start Menu and then click Network and Internet.
2. Click Cellular a list of available access points will appear.
3. Click the access point and click Connect.
4. The system will connect to your network.
5. Connected will appear under the connection.
6. You can then access the internet, download e-mail etc. as per any internet connection.
7. To disconnect you can select the connection and click Disconnect.
8. You need to use Airplane Mode aboard aircraft.
9. You can also click the Wireless icon in the notification area of the taskbar, click Cellular and double-click an access point connect to access the connection information.
Chapter 7: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

• **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1-10) to see the computer’s power status.

• **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

• **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Configuring the Power Buttons” on page 3-9), the Fn + F12 key combination, or power button to wake-up the system.

• **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness (see Table 1-4, on page 1-16).

• **Display Choice** - Press Fn + F7 to make sure the system is not set to “external only” display.

• **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive.
Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Boot** password for the SCU (see “Security Menu” on page 5 - 11).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc. (even if just brief notes).

**Bottom Cover Removal Warning**

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your distributor/supplier for further information.
**Viruses**

- Install an **Anti-Virus** program and keep the **definitions file** (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. **Anti-Virus** programs are commercially available and the **definitions file updates** are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. **Viruses** are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most **Anti-Virus** programs to check all e-mail attachments. **Note:** You should also beware of files from people you know as the virus may have infected an **address book** and been automatically forwarded without the person’s knowledge.

- Keep a “**Bootable CD-ROM/DVD-ROM/USB storage device**” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many **Anti-Virus** programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if as this may violate the terms of your warranty.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).

- Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.
Troubleshooting

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; **Example** - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
## Troubleshooting

### Problems and Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the <strong>power</strong> but it doesn’t work.</td>
<td><strong>Battery missing / incorrectly installed.</strong> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery <strong>LED power</strong> indicator is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing <strong>battery power</strong> too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a <strong>Power Options</strong> scheme (see “<strong>Power Plans</strong>” on page 3 - 5) check its settings. You may also be using a peripheral device/USB device that is drawing a lot of power.</td>
</tr>
</tbody>
</table>
| Actual **battery operating time** is shorter than expected. | **The battery has not been fully discharged before being recharged.** Make sure the battery is fully discharged and recharge it completely before reusing (see “**Battery Information**” on page 3 - 17).  
**Power Options have been disabled.** Go to the **Control Panel** in **Windows** and re-enable the options.  
**A peripheral device/USB device is consuming a lot of power.** Turn off/remove the unused device to save power. |
Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels <strong>too hot</strong>.</td>
<td>Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 17, 1 - 22 &amp; 1 - 24). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan intakes to be blocked.</td>
</tr>
<tr>
<td>The system will not wake up from a power saving state (Sleep/Hibernate) on network activity (Wake on LAN) even though I have plugged in the powered AC/DC adapter.</td>
<td><strong>Wake on LAN is supported in AC mode only.</strong> When the system enters a power saving state the plugged in AC/DC adapter should be connected, and should remain connected, in order to allow the system to wake up on network activity. Unplugging the adapter, and then plugging it back in again, will not allow the system to wake up on network activity.</td>
</tr>
<tr>
<td>No image appears on the <strong>external monitor</strong> I have plugged in and powered on.</td>
<td><strong>You haven’t installed the video driver and configured it appropriately from the Control Panel.</strong> See Appendix C for instructions on installing and configuring the video driver.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
</table>
| **Nothing appears on screen.** | *The system is in a power saving mode.* Toggle the sleep/resume key combination, **Fn + F12** (see “Configuring the Power Buttons” on page 3 - 9).  
*The screen controls need to be adjusted.* Toggle the screen control key combinations **Fn + F8/F9**. If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls.  
*The computer is set for a different display.* Toggle the screen display key combination, **Fn + F7**. If an external monitor is connected, turn it on.  
*The screen saver is activated.* Press any key or touch the **TouchPad**. |
| You forget the **boot password**. | **If you forget the password, you may have to discharge the battery of the CMOS.** Contact your service representative for help.                                 |

---

**Password Warning**

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The sound cannot be heard or the <strong>volume</strong> is very low.</td>
<td><em>The volume might be set too low.</em> Check the volume control in the <strong>Volume Control Panel</strong> in the Windows notification area, or use the key combination <strong>Fn + F5</strong> and <strong>F6</strong> (see “Function Keys &amp; Visual Indicators” on page 1 - 16) to adjust.</td>
</tr>
<tr>
<td>Unwelcome numbers appear when typing.</td>
<td><strong>Num Lock is turned ON</strong> (see “LED Indicators” on page 1 - 10).</td>
</tr>
</tbody>
</table>

**Other Keyboards**

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not work.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>system freezes</strong> or the screen goes dark.</td>
<td><strong>The system’s power saving features have timed-out.</strong> Use the AC/DC adapter, press the sleep (<strong>Fn + F12</strong>) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a <strong>power saving mode</strong>.</td>
<td>Power Options features are not enabled. Go to the <strong>Windows</strong> Power Options menu and enable the features you prefer (see “Power-Saving States” on page 3 - 7). Make sure you have enabled <strong>Hibernate</strong> mode from the control panel.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Wireless LAN/Bluetooth</strong> modules cannot be detected.</td>
<td><em>The modules are off as the computer is in Airplane Mode.</em> Check the LED indicator to see if it is in Airplane Mode (see “LED Indicators” on page 1-10). Use the Fn + F11 key combination to toggle Airplane Mode on/off (see Table 1-4, on page 1-16).</td>
</tr>
<tr>
<td>The <strong>PC Camera</strong> module cannot be detected.</td>
<td><em>The module is off.</em> Press the Fn + F10 key combination in order to enable the module (see “Function Keys &amp; Visual Indicators” on page 1-16). Run the camera application to view the camera picture.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN/Bluetooth</strong> modules cannot be configured.</td>
<td>The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions for the appropriate module in “Wireless LAN Module” on page 6-2 and/or “Bluetooth &amp; WLAN Combo Module” on page 6-12).</td>
</tr>
<tr>
<td>A file cannot be copied to/from a connected <strong>Bluetooth</strong> device.</td>
<td><em>The transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported).</em> If you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process has been completed.</td>
</tr>
<tr>
<td><strong>No sound</strong> can be heard through an <strong>HDMI</strong> connected display.</td>
<td><em>You have not configured the HDMI audio output.</em> See “HDMI Audio Configuration” on page C-9.</td>
</tr>
<tr>
<td><strong>Audio Volume is too low</strong> when listening through <strong>headphones</strong>.</td>
<td><em>You have set the Speaker Configuration to 5.1 or 7.1 Speaker.</em> It is recommended that you set the Speaker Configuration to <strong>Stereo</strong> (not to 5.1 or 7.1 Speaker) when listening through headphones in order to maximize audio quality. See “Audio Features” on page 2-7.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Sound Blaster audio controls don’t work when the system is connected to an external display through an HDMI/Display Port cable.</td>
<td>Note that Sound Blaster Audio will be disabled when you are connecting to an external display through an HDMI or Display Port connection. See “Sound Blaster Audio &amp; HDMI” on page C - 11.</td>
</tr>
<tr>
<td>The fingerprint reader has problems scanning fingers.</td>
<td>When fingers are wet or sweaty the software application may have difficulty reading a scanned finger. Make sure your fingers are clean and dry when attempting to scan them across the sensor for detection.</td>
</tr>
</tbody>
</table>
| When using a Bluetooth headset the audio appears to be mono and not stereo. | This is a common issue with Bluetooth headsets. To resolve this issue do the following (you will need to repeat this procedure after every boot up, restart, or when the system resumes from hibernation):  
  1. Go to the Devices & Printers control panel in Windows.  
  2. Double-click the Bluetooth headset.  
  3. Click Connect to complete the stereo connection.  
 OR  
  1. Go to the Sound control panel in Windows.  
  2. Right-click (in the Playback tab) the Bluetooth Stereo Audio device (the default device is Headset).  
  3. Click Connect to complete the stereo connection. |
I have used Update Driver in Device Manager (Unknown device > Other Devices) to try and install the Airplane Mode driver. Windows encountered a problem in attempting to update the driver, and a yellow exclamation mark appears in Device Manager against the Unknown device.

### Problem Possible Cause - Solution

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>It is very important that the drivers are installed in the order indicated in Chapter 4 (which is the numbered installation order on the Device Drivers &amp; Utilities + User’s Manual disc). This issue can occur when drivers are manually installed, and not in the correct order.</td>
<td>If you have attempted to Update Driver from the Device Manager control panel and have encountered problems, then use the method below to correct this:</td>
</tr>
<tr>
<td>To correct this problem:</td>
<td></td>
</tr>
<tr>
<td>4. Go to the Programs and Features (Programs) control panel in Windows.</td>
<td></td>
</tr>
<tr>
<td>5. Select any installed Airplane Mode driver item (e.g. Insyde Airplane Mode HID Mini-Driver), and click Uninstall/Change to uninstall the current driver.</td>
<td></td>
</tr>
<tr>
<td>6. Restart the computer.</td>
<td></td>
</tr>
<tr>
<td>7. Insert the Device Drivers &amp; Utilities + User’s Manual disc and click Install Drivers (button).</td>
<td></td>
</tr>
<tr>
<td>8. Double-click the Airplane Driver item in the menu.</td>
<td></td>
</tr>
<tr>
<td>9. Follow the instructions to install the correct driver (you will need to restart the computer as part of the installation process).</td>
<td></td>
</tr>
</tbody>
</table>
Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
# Interface (Ports & Jacks)

## Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader</td>
<td>The card reader allows you to use the following digital storage cards: MMC (MultiMedia Card) / RSMMC&lt;br&gt;sd (Secure Digital) / Mini SD / SDHC / SDXC (up to UHS-II)&lt;br&gt;Push the card into the slot and it will appear as a removable device.</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>External Monitor (VGA)</td>
<td>This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or simultaneous display on the LCD and external monitor/FPD.</td>
</tr>
<tr>
<td>Mini DisplayPort 1.2</td>
<td>The Mini DisplayPort is a miniaturized version of the DisplayPort, which is a digital display interface standard that allows a digital audio/video interconnect, between the computer and its external display or a home-theater system.</td>
</tr>
</tbody>
</table>

---

**Mini DisplayPort Cables**

When using cables connected to the Mini DisplayPort, **try to make sure that the cables are not bent excessively**, as bending the cables may cause signal problems.
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HDMI-Out Port</strong></td>
<td>The <strong>High-Definition Multimedia Interface</strong> port is an audio/video connector interface for transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Attaching Other Displays” on page C - 30) by means of a HDMI cable. <strong>Note</strong>: HDMI carries both audio and video signals.</td>
</tr>
<tr>
<td><strong>Headphone-Out Jack</strong></td>
<td>Headphones or speakers may be connected through this jack. <strong>Note</strong>: Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td><strong>Microphone-In Jack</strong></td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td><strong>RJ-45 LAN Jack</strong></td>
<td>This port supports LAN (Network) functions. <strong>Note</strong>: Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td><strong>S/PDIF-Out Jack</strong></td>
<td>This S/PDIF (<strong>Sony/Philips Digital Interface Format</strong>) Out Port allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.</td>
</tr>
<tr>
<td><strong>Security Lock Slot</strong></td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB 3.0 Port</td>
<td>These USB ports are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
Appendix B: Control Center & Flexikey®

Overview

The following chapter will give a quick description of the functions of the Control Center & Flexikey® applications.

Control Center

The Control Center gives quick access to frequently used controls, power management features and enables you to quickly turn modules on/off. Click the Control Center icons to toggle the appropriate function, or hold the mouse button down and move the dial control where applicable. Certain functions will automatically be adjusted when a power mode is selected. The Control Center in Windows 10 works under the Desktop app and not under the Start screen.

Flexikey®

The Flexikey® application is a quick hotkey configuration application, which allows you to assign a single key to launch multiple key combinations, or to launch programs and applications, to create text macros and to disable certain keys. The application can also be used to configure the mouse buttons to create hotkeys for gaming etc. All the configuration settings are retained under (up to 12) profiles to which the settings are applied. Click Flexikey® in the Gaming section of the Control Center, or the click the icon in the notification area of the taskbar, to launch the application.
Control Center Access

To run the Control Center press the \texttt{Fn + Esc} key combination, or double-click the icon in the notification area of the taskbar. Close the Control Center by clicking the close icon in the top right of the panel (move the cursor onto the top right corner of the panel to highlight it).

Flexikey® Access

The Flexikey® is accessed from within the Control Center by clicking \texttt{Flexikey® in the Gaming section of the Control Center.}

\textit{Figure B - 1 - Control Center & Flexikey®}
Power Modes
You can set a **Power Mode** by clicking the appropriate icon at the top of the **Control Center**. Each power mode will affect the Power Conservation Mode, Airplane Mode, Power Plan and PC camera power etc.

You can click a **Control Center** icon to set an overall power mode and then click individual icons in the **Control Center** to power on/off the Touchpad and PC camera.

<table>
<thead>
<tr>
<th>Modes</th>
<th>Quiet</th>
<th>Power Saving</th>
<th>Performance</th>
<th>Entertainment</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Quiet Mode</strong> will set the Fan Speed to <strong>Silent</strong>.</td>
</tr>
<tr>
<td>Power Plan</td>
<td>Balanced</td>
<td>Power Saver</td>
<td>High Performance</td>
<td>Balanced</td>
<td></td>
</tr>
<tr>
<td>Power Conservation Mode</td>
<td>Balance</td>
<td>Energy Star</td>
<td>Performance</td>
<td>Balance</td>
<td></td>
</tr>
<tr>
<td>PC Camera</td>
<td>ON</td>
<td>OFF</td>
<td>ON</td>
<td>ON</td>
<td><strong>Silent</strong> the System Power Plan will be set to <strong>Power Saver</strong> and the <strong>Power Conservation Mode</strong> will be set to <strong>Energy Star</strong>.</td>
</tr>
<tr>
<td>TouchPad</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td><strong>Silent</strong> the System Power Plan will be set to <strong>Power Saver</strong> and the <strong>Power Conservation Mode</strong> will be set to <strong>Energy Star</strong>.</td>
</tr>
<tr>
<td>Airplane Mode</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td><strong>Silent</strong> the System Power Plan will be set to <strong>Power Saver</strong> and the <strong>Power Conservation Mode</strong> will be set to <strong>Energy Star</strong>.</td>
</tr>
</tbody>
</table>

*Table B - 1- Power Modes*
Control Center Menus

The Control Center contains 3 menu headings (System Program, Device and Gaming) under the Power Modes. Click the menu headings and then click any of the buttons outlined on the following pages.
Power Status (System Program)
The Power Status icon will show whether you are currently powered by the battery, or by the AC/DC adapter plugged in to a working power outlet. The power status bar will show the current battery charge state.

Brightness (System Program)
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight (press any key to turn it on again).

Volume (System Program)
The Volume icon will show the current volume level. You can use the slider to adjust the Volume or the Fn + F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Fan Speed (System Program)
You can set the fan speed to Maximum (full power), Automatic or Custom from this menu item. The fan speed will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum if you prefer. Select Custom and click on the sliders to adjust the settings to your preference, however these settings can be overridden by the system, as a safety precaution, if it requires heavier use of the fan.

Custom Settings
Click Save to retain customized settings, or Reset to select default settings.
Control Center & Flexikey®

Power Conservation (System Program)
This system supports Power Saving power management features that place computers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period of inactivity (see “Power Conservation Modes” on page 3 - 12). Click either the Performance, Balanced or Power Saving button.

Sleep Button (System Program)
Click either the Hibernate or Sleep buttons to have the computer enter the selected power-saving mode (see “Power-Saving States” on page 3 - 7).

Desktop Background (System Program)
Clicking the Desktop Background button will allow you to change the desktop background picture.

Display Switch (System Program)
Click the Display Switch button to access the menu (or use the + P key combination) and select the appropriate attached display mode.

Time Zone (System Program)
Clicking the Time Zone button will access the Date and Time Windows control panel.
**Control Center & Flexikey®**

**TouchPad/Camera (Device)**
Click either of these buttons to toggle the TouchPad or camera module’s power status. The icon will appear dimmed when it is off. Note that the power status of the camera module is also effected by the **Power Mode** selected (see *Table B - 1, on page B - 3*).

**Caps Lock/Scroll Lock/ Number Lock/Airplane Mode**
Click the button to toggle the appropriate lock mode and Airplane Mode.

**Left Windows Key (Gaming)**
Click **Disable** to disable the Windows Key on the left side of the keyboard. This may be useful if you are using the gaming keys (W, A, S & D) and wish to avoid accidentally triggering menus with the Windows Key.

**Headphone (Gaming)**
The headphones may be set for different effects using this menu.

**Flexikey® (Gaming)**
Click the button to access the **Flexikey®** application.
Flexikey® Application

Click the button \( \Box \) in the Control Center, or the click the icon \( \Box \Box \) in the notification area of the taskbar, to access the Flexikey® application.

Profiles

The menus on the left side of the application relate to Profiles. You can Add or Delete Profiles (you can maintain 12 active Profiles), Export and Import profiles from the menus. If you double-click on a Profile you can change the Profile Name, and change an Image file (images created using PNG files).

Windows Key & P Key
Note that you can assign actions to any keyboard key except the Windows key and P key.

Figure B - 3 - Flexikey® - Profiles
Flexikey® Application Features

- **EXPRESS KEY** - This feature allows you to configure a single key to send multiple key combinations or to create more useful shortcut keys. This is useful in gaming or when using applications which have a complex set of keyboard shortcuts.
- **LAUNCH APP** - This simply assigns single keys to launch any program’s or application’s executable file.
- **EXPRESS TEXT** - With this you can assign single keys to send commonly used strings of text.
- **DISABLE** - Use this function to disable any keyboard keys.
- **STATISTICS** - Use this to quickly record keys in use in any application, and to disable unused keys.

Keyboard and Mouse Settings

Click **Enable** to create settings for the keyboard and/or mouse by clicking the button on the top left of the screen (e.g. you may wish to create a profile with settings only for the mouse or keyboard). Clicking on the keyboard or mouse icons will allow you to access the settings page for the either the keyboard or mouse.

![Figure B - 4 - Enable Keyboard & Mouse / Language Selection](image)

Language Interface

You can change the language interface by right-clicking the icon in the notification area of the taskbar and selecting the language from the menu.
Enabling or Disabling Flexikey®

You can enable or disable Flexikey® (and therefore any hotkeys or mouse profile functions currently in use) by using the **Fn + Backspace** key combination. Pressing this key combination will toggle you between the currently selected keyboard or mouse profile to the standard keyboard and/or mouse settings, and back again.

*Use Fn + Backspace to Enable or Disable Flexikey®*

The icon Flexikey® icon in the notification area of the taskbar will appear grayed out when Flexikey® is off, and in color when on (an on screen icon will also pop-up to display the status of the application as it is toggled on/off).

*Figure B - 5 - Enable/Disable Flexikey®*

*Figure B - 6 - Taskbar Notification Area Icons*
Keyboard Settings

The keyboard settings allow you to configure actions for any single key (or a combination of keys). Click the key and then select the Action Type (Express Key, Launch App, Express Text or Disable) from the menu at the bottom of the page. You can rename the action by clicking in the Name box, and click in Tool Tips to type in a note to remind you of the action’s function.

Figure B - 7 - Key Configuration

Windows Key \& P Key
Note that you can assign actions to any keyboard key except the Windows key and P key.
Control Center & Flexikey®

Mouse Settings
When an external mouse is attached, the mouse settings allow you to configure actions for the left 1, right 2, and middle 3 buttons of the attached mouse, and also for any backward 4 and forward 5 buttons if applicable (on a gaming type mouse). Click the button number and then select the Action Type (Express Key, Launch App, Express Text or Disable) from the menu at the bottom of the page. You can rename the action by clicking in the Name box, and click in Tool Tips to type in a note to remind you of the action’s function.

Figure B - 8 - Mouse Configuration
Keyboard Settings - Express Key

To configure a single key to send multiple key combinations, or to create more useful shortcut keys, use Express Key.

1. **Enable** and select the keyboard under your chosen profile, click on a key to select it, and then click to select Express Key in Action Type.
2. In the following example we want to change an existing game key configuration which uses the left shift key for sprinting, and the W key for moving forwards, to use the left Ctrl key to combine this movement to sprint forward.
3. Click on the chosen key for the shortcut action.
4. Click in the Tool Tips field and type to give the key combination a name e.g. “Sprint Fwds”, then click back in the Name field (to avoid adding the recorded keys to the Tool Tips name).
5. Click Start Record and then press the key or keys (in this case we will press Left Shift and W) required (make sure you press the key(s) required and do not click on them).
6. Click Stop Record to complete the process.

![Image of the Express Key settings interface]

*Figure B - 9- Express Key Record Key Combination*
7. Click **Save** to save the settings within your chosen profile.
8. If you want to remove any individual key click to select it, and then click **Delete**.
9. If you want to clear all the settings click **Restore** to return to the default key setting.
10. Any assigned **Express Keys** will appear in **orange**.

![Control Center & Flexikey®](image)

**Figure B - 10 - Key Combination Set**

**Tool Tips**

The Tool Tips field allows you to type a note to remind yourself of the function you have programmed the key for under any Profile.
Enabling Time Record
If you want to create a delay between key presses within the key combination, then you can use Time Record function to do so.

1. **Enable** and select the keyboard under your chosen profile, click to select a key for the shortcut action, and then click to select **Express Key** in **Action Type**.
2. Click in the **Tool Tips** field and type to give the key combination a name, then click back in the Name field (to avoid adding the recorded keys to the Tool Tips name).
3. Click **Start Record** and then press the key or keys required in the sequence and time delay between key presses required (make sure you **press the key(s) required** and do not click on them).
4. Click **Stop Record**.
5. Click to select a key in the sequence and click **Enable Time Record** , then click a key to view the time delay.

![Figure B - 11 - Enable Time Record](image)
6. You can edit the delay between key presses by clicking in the **Delay Time (MS)** field and typing a new number for the delay between the key presses.

![Figure B - 12 - Time Record Between Key Presses](image)

7. Click ✗ to close the Time Record window.
8. Click **Save** to save the settings within your chosen profile.
9. If you want to remove any individual key click to select it, and then click **Delete**.
10. If you want to clear all the settings click **Restore** to return to the default key setting.
Keyboard Settings - Launch App

You can configure keys to launch any application or program as follows:

1. **Enable** and select the keyboard under your chosen profile, click to select a key to launch the application, and then click to select Launch App in Action Type.
2. Click **Browse...** at the bottom right of the application window.

*Figure B - 13 - Keyboard - Launch App (Browse to Executable File)*
3. Navigate to the executable file of the application and click Open.
4. The key will now be configured to open the selected application under your chosen Profile, and the key will appear in green.

5. If you want to remove any Launch App Key, select it and click on Restore.
6. Click Save to save the settings within your chosen profile.

B - 18 Keyboard Settings - Launch App
Keyboard Settings - Express Text

A single key can be set to send a string of text within any application using Express Text.

1. **Enable** and select the keyboard under your chosen profile, click to select a key, and then click to select Express Text in Action Type.
2. Click in Start key if required (the Start key is the key used to in your target program to open a text message), or you can leave it blank if you prefer.
3. Click in the Click to type field and type in your message.

*Figure B - 15 - Keyboard - Express Text*
Control Center & Flexikey®

4. Click in Send key if required (the Send key is the key used to in your target program to send a text message e.g the Enter key would be the most commonly used), or you can leave it blank if you prefer.
5. The key will now be configured to send the text message in the target program under your chosen Profile, and the key will appear in blue.
6. If you want to remove any Express Text key, select it and click on Restore.
7. Click Save to save the settings within your chosen profile.

Copy & Paste Text

Note that some applications and games do not support copy and pasted text. Where this is the case, any text you may have copy and pasted in to the “Type to Text” field may not be displayed within the application. In this case you will need to type the text into the field instead.
Keyboard Settings - Disable

You can use the program to disable any keys not required.

1. **Enable** and select the keyboard under your chosen profile, click to select a key to disable, and then click to select **Disable** in **Action Type**.
2. The key will now be disabled.
3. If you want to enable the key again, select it and click on **Restore**.
4. Click **Save** to save the settings within your chosen profile.
5. The key will be disabled under your chosen Profile, and the key will appear in **Gray**.

![Figure B - 16 - Keyboard - Disable](image)
Mouse Settings - Express Key

To assign a mouse button click to send multiple key combinations (an external mouse must be attached), or to create more useful shortcut keys, use Express Key.

1. **Enable** and select the mouse under your chosen profile, click on a mouse button to select it, and then click to select **Express Key** in **Action Type**.
2. In the following example we will configure the central mouse wheel to combine the actions of **left shift** key for sprinting, and the **W** key for moving forwards in a game program.
3. Click on the central mouse wheel for the shortcut action.

![Figure B - 17 - Mouse - Express Key Record Key Combination (Mouse)](image)
4. Click in the Tool Tips field and type to give the key combination a name e.g. "Sprint Fwds", then click back in the Name field (to avoid adding the recorded keys to the Tool Tips name).
5. Click Start Record and then press the key or keys (in this case we will press Left Shift and W) required (make sure you press the key(s) required and do not click on them).
6. Click Stop Record to complete the process.
7. Click Save to save the settings within your chosen profile.
8. If you want to remove any mouse setting click to select it, and then click Delete.
9. If you want to clear all the settings click Restore to return to the default mouse setting.
10. The mouse button for any assigned Express Keys will appear in orange.

Enabling Time Record for Mouse Settings
If you want to create a delay between key presses within the mouse click combination, then you can use Time Record function to do so in the same manner as that used for keyboard settings (see “Enabling Time Record” on page B - 15).
Mouse Settings - Launch App

You can assign a mouse button click to launch any application or program as follows:

1. **Enable** and select the mouse under your chosen profile, click on a mouse button to select it, and then click to select **Express Key** in **Action Type**.
2. Click **Browse...** at the bottom right of the application window.

![Figure B - 18 - Mouse - Launch App (Browse to Executable File)](image-url)
3. Navigate to the executable file of the application and click **Open**.
4. The mouse click will now be configured to open the selected application under your chosen Profile, and the button will appear in **green**.
5. Click **Save** to save the settings within your chosen profile.

*Figure B - 19 - Mouse Button Set to Launch App*
Mouse Settings - Express Text

A mouse button click can be set to send a string of text within any application using Express Text.

1. **Enable** and select the mouse under your chosen profile, click on a mouse button to select it, and then click to select **Express Text** in **Action Type**.
2. Click in **Start** key if required (the **Start** key is the key used to in your target program to open a text message), or you can leave it blank if you prefer.
3. Click in the **Text Context** field and type in your message.
4. Click in **Send** key if required (the **Send** key is the key used to in your target program to send a text message e.g the Enter key would be the most commonly used), or you can leave it blank if you prefer.

5. The mouse button click will now be configured to send the text message in the target program under your chosen Profile, and the button will appear in **blue**.

6. If you want to remove any **Express Text** mouse button, select it and click on **Restore**.

7. Click **Save** to save the settings within your chosen profile.
Mouse Settings - Disable

You can use the program to disable any mouse button clicks if not required.

1. **Enable** and select the mouse under your chosen profile, click on a mouse button to select it, and then click to select **Disable** in **Action Type**.
2. The button click will now be disabled.
3. If you want to enable the button again, select it and click on **Restore**.
4. Click **Save** to save the settings within your chosen profile.
5. The button click will be disabled under your chosen Profile, and the key will appear in **Gray**.

![Figure B - 21 - Mouse - Disable](image)
Statistics

The **Statistics** tab allows you to record keys used in any application, and to **disable** any infrequently, or unused, keys to save any accidental incorrect key presses.

1. Click the **Statistics** Tab, and press **Start Record** to start recording the frequency of key presses for keys used.
2. You can then go to the application you wish to use the profile for, and use the application as normal so that a standard set of keys used may be recorded.
3. Return to the Flexikey® application and press **Stop Record** to stop recording.
4. At the end of the recording process colors will represent the frequency of key presses, with red as the most frequent through to lighter blue the less frequent (the color bar at the bottom of the screen displays the color code against the number of key presses).
5. Under **Quick Disable** click the color which corresponds to the keys you wish to disable.
6. All disabled keys will then change to gray and will be disabled under this profile.
Control Center & Flexikey®
Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1-32. Make sure you install the drivers in the order indicated in Table 4-1, on page 4-4.

The basic video features for this computer can be configured using the Intel(R) HD Graphics Control Panel. Further video configuration is available through the NV-IDA control panel.

Video Driver Installation

Video (VGA)
1. Click Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the license agreement.
3. Click Next.
4. Click Close to complete the installation.
Microsoft Hybrid Graphics

Most notebook computers come with either a discrete or integrated graphics solution.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU) which are capable of playing games, watching HD video or running GPU-based applications. However computers with discrete graphics solutions tend to be heavy in power consumption, and slightly larger in size in order to incorporate the dedicated discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help save power consumption and allow for longer battery life. However computers with integrated graphics solutions will not usually run games, HD video or GPU-based applications without severe limitations.

Microsoft Hybrid Graphics is a seamless technology designed to get best performance from the graphics system while allowing longer battery life, without having to manually change settings. Thus when an application is run that requires extra performance or quality, then the system will run the discrete GPU (dGPU); when the system does not require such enhanced performance it will let the integrated (iGPU) handle it.
How the Technology works
When the system is powered up and is displaying just the desktop, the dGPU will be powered off. In this case the system is running in the same way as a system without a discrete graphics solution. However when an application that requires use of the dGPU is run (e.g, a game or HD Video), the dGPU is powered on and takes over the processing duties. If the program is closed, then the dGPU will be powered back down again until required.
Intel® Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much system memory (RAM) as needed to the integrated video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system.
Configure Other Displays Using Project

You can configure attached displays from Project.
1. Attach your display to the appropriate port, and turn it on.
2. Press the `Alt` + `P` key combination.
3. Click on any one of the options from the menu to select **PC screen only**, **Duplicate**, **Extend** or **Second screen only**.
4. You can also click **Connect to a wireless display** at the bottom of the Project screen and follow the steps to connect to any wireless enabled display.

![Project menu options](image)
Configuring an External Display In Windows

1. Attach your external display to the appropriate port, and turn it on.
2. Go to the Control Panel.
3. Click Display (icon) and Adjust Resolution (Appearance and Personalization).
4. Click the Detect button.
5. The computer will then detect any attached displays.

Figure C - 2
Screen Resolution
Multiple Displays

You can configure attached displays from Project.
6. You can configure the displays from the **Multiple Displays** menu.

- Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s)
- Extend these displays - Treats both connected displays as **separate** devices
- Show desktop only on 1/2 - Only one of your displays is used.

*Figure C-3*

Screen Resolution

Multiple Display Options

You can configure attached displays from Project. C - 7
The **System** Control Panel in **Settings** may also be used to configure displays.

1. Attach your external display to the appropriate port, and turn it on.
2. Click the Start Menu and click **Settings > System** (or right-click the desktop and select **Display Settings**).
3. You can change Duplicate, Extend or choose to display on 1 screen only.
4. Click **Apply** to save any changes made.
5. Click **Advanced display settings** to access further options.
HDMI Audio Configuration

HDMI (High-Definition Multimedia Interface) carries both audio and video signals. In some cases it will be necessary to go to the Sound control panel and manually configure the HDMI audio output as per the instructions below.

1. Go to the Sound control panel.
2. Click Playback (tab)
3. The playback device will be selected.
4. You may need to select the audio device and click Set Default (button).
5. Double-click the device to access the control panel tabs.

Volume Adjustment

The sound volume level can be clicking using the volume control icon in the notification area of the taskbar.

Figure C - 5
Sound - HDMI Device (set Default)
6. Adjust the HDMI settings from the control panel tabs.
7. Click **OK** to close the **Sound** control panel.

---

**Figure C - 6**

HDMI Device Properties

---

**C - 10 HDMI Audio Configuration**
**HDMI Notes**

- Connect a device with HDMI support to the HDMI-Out port **BEFORE** attempting to play audio/video sources through the device.
- To play audio sources through your external display’s (TV or LCD) speakers you will need to go to the audio configuration control panel on the display and configure the audio input accordingly (see your display device manual).

**HDMI Video Configuration**

1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “**Attaching Other Displays**” on page C - 30.
3. Set up your external display (TV or LCD) for HDMI input (see your display device manual).
4. You can now play video/audio sources through your external display.

**Sound Blaster Audio & HDMI**

1. When you connect an HDMI display to the HDMI-Out port, the Sound Blaster Cinema EQ controls will be disabled.
2. A warning box will pop-up and will prompt “...**Do you want to select another audio device now?**”.
3. Click **No** to continue using the HDMI audio output from your external display (do not attempt to select another audio device when connected to the external HDMI display).

---

**Other Applications**

If you are using a third party application to play DVDs etc. from any attached DVD device, you will need to consult the application’s documentation to see the appropriate audio configuration (the application must support digital to analog translation).
Wireless Display

Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo module (you need to make sure that your video adapter/display device is compatible with your particular WLAN/Combo module) in conjunction with a compatible video adapter/display device (purchased separately) to allow you to display the contents of the notebook display on another display (e.g. HDTV), without the need to have cables stretching across a room.

You can use the wireless display to play games, browse the internet, display videos or photo slide shows on your TV/external display without using HDMI or A/V cables.

Before configuring Wireless Display you will need to set up your compatible adapter with your display/speakers. Connect the adapter using an HDMI or A/V cable and turn on the display (or in the case of speakers connect them to the wireless speaker adapter with the cables provided with the adapter), and then set the display to the appropriate input channel (see the documentation supplied with your compatible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 10.
Wireless Display Configuration

1. Note that no driver or application is required for wireless display in Windows 10.
2. Press the + P key combination.
3. Click Connect to a wireless display at the bottom of the Project screen and follow the steps to connect to any wireless enabled display.

4. The system will then search for compatible display devices (this may take up to 60 seconds so allow time for this to complete).
5. Double-click any detected display device in the list.
6. You may then need to input a pin number for the device to which you are connecting and click **Next**.
7. The display will then connect (for specific settings for your display see the documentation supplied with your compatible adapter/display for full details).
8. Go to the **Project** menu and click **Disconnect** to temporarily disconnect from the wireless display.
9. To permanently disconnect from the display (you will need to go back through the connection process again) you can select it in **Devices** and click **Remove Device > Yes**.
Intel® HD Graphics Control Panel

Advanced video configuration options are provided by the Intel® HD Control Panel. To access the control panel see below and overleaf:


   OR

2. Right-click the Desktop and select Graphics Properties from the menu.

   Figure C - 8
   Apps Screen
   Intel® HD Graphics
   Control Panel

   Figure C - 9
   Right-Click Desktop
   (Graphics Properties)
OR
3. Click **Advanced settings** in the **Screen Resolution** control panel in **Windows**.
4. Click the **Intel(R) HD Graphics Control Panel** tab and click **Graphics Properties** (button).

OR
5. Double-click the **Intel(R) HD Graphics** control panel in the **Windows Control Panel**.

*Figure C - 10*
**Screen Resolution > Advanced Settings > Intel® HD Graphics Control Panel**
You may make changes to any of the graphics properties by clicking the appropriate menu panel and adjusting the settings from the menus.

Figure C - 11
Intel® HD Graphics Control Panel
Video Driver Controls

Display
Click either Display Settings or Color Settings to make display adjustments, including configuration for any attached external displays.

Figure C - 12
Intel® HD Graphics Control Panel
Display

Multiple Display
At least one other display must be attached in order to view multiple display selection options.
Click the **Display** menu at the top of the screen to display the sub-menus. The **Multiple Displays** menu allows you to configure the display mode of any attached displays (see “**Attaching Other Displays**” on page C - 30). Click **Apply** to save any changes made.

**Multiple Display**
At least one other display must be attached in order to view multiple display selection options.

**Audio Settings**
Any attached active displays must have audio capacity to allow audio configuration.

**Figure C - 13**
Intel® HD Graphics Control Panel
Display - Multiple Displays
The **Custom Resolutions** sub-menu allows you to adjust the display (or any attached display) to any width, height, refresh rate, color depth and underscan percentage of your choice. Note that incorrect settings can cause system instability and even possible component damage, so this is adjusted at your own risk.
3D
This menu allows you to choose how 3D images are displayed. Performance gives the smoothest motion of images, Quality displays the most detail, Balanced Mode provides better computer performance with good quality and Custom allows you to configure the Anisotropic Filtering and Vertical Sync and features to your preferences. Click Apply to save changes.

Figure C - 15
Intel® HD Graphics Control Panel 3D
Options and Support

Hot Key Manager in Options and Support allows you to create hot keys for opening the application, rotating the display, scaling etc. Click Apply to save changes.

Figure C - 16
Intel® HD Graphics Control Panel Options and Support
Click the **Options** menu at the top of the screen to display the sub-menus. The **Information Center** provides details on **System Information**, the **Built-In Display** and any **attached displays**.

![Intel® HD Graphics Control Panel](image)

### Preferences

Go to the **Preferences** sub-menu in Options to configure the preferences for the Intel® HD Graphics Control Panel.

Make sure you click **Enable** under **Tray Icon** to display the Intel® HD Graphics Control Panel icon in the notification area of the taskbar (as below).

### Figure C - 17

Intel® HD Graphics Control Panel Options - Information Center
Video

The **Video** menu allows you to brighten or darken movies, or to switch to vivid colors. The **Preview** image will display a sample image using the current settings. You can **Save Profile** and name the Profile to recall the settings at any time. Click **Apply** to save changes (select **Color Enhancement**, **Image Enhancement**, **Image Scaling** or **Gamut Mapping** from the menu).

---

*Figure C - 18*

Intel® HD Graphics Control Panel - Video (Color Enhancement)
Click the **Video** menu at the top of the screen to display the sub-menus. The **Image Enhancement** menu allows you to adjust the **Sharpness**, **Skin Tone Enhancement** in the **Basic** menu, and **Noise Reduction**, **Contrast Enhancement** and **Film Mode Detection** in the **Advanced** menu. Click **Apply** to save changes.

**Figure C - 19**
Intel® HD Graphics Control Panel - Video (Image Enhancement Basic)
Enable **Image Scaling** to use the sliders to adjust the scaling.

*Figure C - 20 Intel® HD Graphics Control Panel Video Image Scaling*
Power
The battery life can be extended through dynamic control of the frame rate if **Extended Battery Life for Gaming** is enabled.

*Figure C - 21*
Intel® HD Graphics Control Panel - Power
Profiles
You can select one of the preset profiles (Brighten Video, Darken Video and Enhance Video Colors) from the menu on the left. Alternatively you can go through the menus to make adjustments to your preferences for Display, Color, Video, 3D, Options and Support and Power (tick any boxes for the settings required), and then Save the settings to a profile (which may be imported or exported).

Figure C - 22
Intel® HD Graphics Control Panel - Profiles
Display Devices & Options

Note that you can use external displays connected to the HDMI-Out port and/or external monitor port and Mini Display (1.2) port. See your display device manual to see which formats are supported.

### Attaching Displays

When you first attach an external display you may find that the desktop does not occupy the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R) HD Graphics Control Panel to configure the full screen display.

<table>
<thead>
<tr>
<th>Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Display</td>
<td>One of the connected displays is used as the display device (PC screen only or Second screen only).</td>
</tr>
<tr>
<td>Clone/Duplicate</td>
<td>Both connected displays output the same view and may be configured independently</td>
</tr>
<tr>
<td>Extended / Extend</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
<tr>
<td>Collage</td>
<td>A number of connected displays are combined into a single unified higher resolution for larger screen sizes</td>
</tr>
</tbody>
</table>

Table C - 1
Display Modes
Attaching Other Displays

To Clone Displays:
1. Attach your external display to the appropriate port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Multiple Displays (sub-menu).
3. Click Clone from the Select Display Mode menu.
4. Click Apply, and OK to confirm the settings change.
5. Select the displays from the Select One or More Active Displays menu.

At least one other display must be attached in order to view Multiple Display selection options.

Figure C - 23
Display > Multiple Displays (Clone)
To Enable Extended Mode:
1. Attach your external display to the appropriate port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Multiple Displays (sub-menu).
3. Click Extended from the Select Display Mode menu.
4. Click Apply, and OK to confirm the settings change.

Display Settings Extended Desktop
You can have different Colors, Screen Area and Monitor Refresh Rates for each display device provided your monitor can support them.
You can drag the monitor icons to match the physical layout of your displays. Icons and programs may also be dragged between the displays.

Click the appropriate monitor icon and drag it to match the physical arrangement you wish to use (e.g. the secondary display may be extended left/right/above/below the primary display).
To Enable Collage Mode:
1. Attach your external display to the appropriate port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Multiple Displays (sub-menu).
3. Click Collage from the Select Multiple Display Mode menu.
4. Click Enable Collage and click On.
5. Click Vertical or Horizontal to arrange and displays as required.
6. Click Apply, and OK to confirm the settings change.

Figure C - 25
Display > Multiple Displays (Collage)
NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Go to the Control Panel.
2. Double-click NVIDIA Control Panel (click to view the control panel in either Large icons or Small icons if you are in Category view).

Figure C - 26
NVIDIA Control Panel
Video Driver Controls

The **NVIDIA Control Panel** provides additional video configuration controls and tools which allow quick access to features such as image settings, 3D Settings and video configuration.

**Navigating the Control Panel**

Navigate through the control panels in much the same way as you would a web page. Click on the sub-heading tasks in the left menu (and on the highlighted links) for information. Use the buttons on the top left to go back, forward etc.

![NVIDIA Control Panel](image)

**Figure C - 27**

**NVIDIA Control Panel**
The **Help** menus provide index and search features, and direct links to the NVIDIA website etc.

![Help Menu](image)
Customization Options

One of the most important aspects of hybrid technology is that it will switch between the integrated GPU and discrete GPU seamlessly and automatically, and does not require any input from the user. However customization options are offered for users who prefer to set their own parameters for GPU usage.

Context Menu

One of the quickest ways to choose which GPU to use for a particular application is by using the “Run with graphics processor” in the context menu.

1. Go to the NVIDIA Control Panel.
2. Click Desktop from the top menu and select Add “Run with graphics processor” to Context Menu (it should have a check alongside it).
3. Close the NVIDIA Control Panel.
4. Find the executable file icon of the application you want to run.
5. Right-click the icon and select Run with graphics processor from the context menu.
6. Select either High-performance NVIDIA processor (dGPU) or Integrated graphics (iGPU) to run the program with the selected GPU.

Note the NVIDIA control panel refers to High-performance NVIDIA processor (which is the discrete GPU) and Integrated graphics (which is the integrated GPU).

Figure C - 30
Context Menu with Run with graphics processor
Video Driver Controls

Customization Options

Although hybrid technology is completely seamless to the user, there are customization options within the control panel (see page C - 35).

Global Settings

Global settings allows you to set the preferred graphics processor for overall use. Ideally this would be the iGPU for battery life, but this can be set to the dGPU if preferred.

1. Go to the NVIDIA Control Panel.
2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).
3. Select either Integrated graphics (iGPU) or High performance NVIDIA Processor (dGPU) from the drop-down menu.
4. Click the Setting menu items to select any options required.
5. Click Apply to save the settings.

Figure C - 31

Global Settings
Program Settings
Program settings allows you to make specific adjustments for installed applications.

1. Go to the **NVIDIA Control Panel**.
2. Click **Manage 3D Settings (3D Settings)** and select **Program Settings** (tab).
3. **Select a program to customize** from the drop-down menu, or click **Add** to add any program that does not appear in the menu.
4. **Select the preferred graphics processor for the program** from the drop-down menu.
5. Click the **Setting** menu items to select any options required.
6. Click **Apply** to save the settings.

![Figure C - 32 Program Settings](image)
Configure Surround, PhysX®

NVIDIA® PhysX® is a physics engine that can use the GPU to accelerate game and 3D application performance. You can select the GeForce video card or CPU as a PhysX® processor, or configure the computer to auto-select a PhysX® processor (recommended default setting).

1. Go to the NVIDIA Control Panel.
2. Click Configure Surround, PhysX.
3. Click to select a processor from the menu (PhysX Settings); Auto-select (recommended) is the default setting.
4. Click Apply to save the settings.

Figure C - 33
Configure Surround, PhysX®
NVIDIA GeForce Experience

If you have a working internet connection (and you will need remain connected to the internet to run NVIDIA GeForce Experience) you can click the NVIDIA GeForce Experience desktop icon (or App) to run the application. This will optimize your gaming settings for your GTX video card by downloading the latest settings from the NVIDIA cloud data center.

After initially running the NVIDIA GeForce Experience application, you should then restart the computer and run the application again in order to install all the updated features.

Figure C - 34
NVIDIA GeForce Experience
My Rig
Video Driver Controls

NVIDIA GeForce Experience Features
• Click the Games tab and click *Scan for games* to update the optimal settings for your installed games from the NVIDIA cloud data center for your PC.
• The Drivers tab allows you to check and download the latest available video driver.
• My Rig provides information on your system and the NVIDIA utilities.
• SHIELD streams your PC games to the NVIDIA SHIELD gaming portable.
• Preferences lists your current preference list.
• ShadowPlay™ allows you to easily record your favorite gaming moments (you can also broadcast your game on Twitch).

Figure C - 35
NVIDIA GeForce Experience Preferences
NVIDIA GeForce Experience - BatteryBoost

BatteryBoost allows you to optimize your system’s battery life when gaming. You can adjust the BatteryBoost slider in Preferences > BatteryBoost (make sure you have restarted the computer after the first run of NVIDIA GeForce Experience).

Running BatteryBoost
1. On first run of NVIDIA GeForce Experience you should be connected to the internet (BatteryBoost will not appear at this stage).
2. After the first run you should restart the computer manually, but you must still be connected to the internet (the LAN cable should be plugged-in, or your WiFi connection should be set to Connect Automatically) as the computer restarts.
3. BatteryBoost will be present when NVIDIA GeForce Experience is run again.

Click to put a tick in the box alongside BatteryBoost to enable the feature, then adjust the slider towards Longer battery life or Higher performance as preferred.

Figure C - 36
NVIDIA GeForce Experience BatteryBoost
NVIDIA GeForce Experience - ShadowPlay

Click on the ShadowPlay icon at the top right of the control panel and then click the power button to enable the feature. You can adjust the settings from the menu buttons.

Figure C - 37
NVIDIA GeForce Experience
ShadowPlay
Appendix D: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer’s release schedule. Check with your distributor/supplier for details.
## Specifications

<table>
<thead>
<tr>
<th>Processor</th>
<th>Memory</th>
<th>Video Adapter Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intel® Core™ i7-6700HK (2.6GHz)</strong>&lt;br&gt;6MB Smart Cache, 14nm (14 Nanometer), DDR3L-1600MHz, TDP 45W</td>
<td><strong>Dual Channel DDR3L</strong>&lt;br&gt;Two 204 Pin SO-DIMM Sockets Supporting <strong>DDR3L 1600 MHz</strong> Memory Modules (real operational frequency depends on the FSB of the processor)&lt;br&gt;Memory Expandable from <strong>4GB</strong> (minimum) up to <strong>16GB</strong> (maximum)&lt;br&gt;Compatible with 2GB/4GB/8GB Modules</td>
<td><strong>Intel® Integrated GPU and NVIDIA® GeForce Video:</strong>&lt;br&gt;Supports <strong>Microsoft Hybrid Graphics Switchable GPU</strong> (GPU Type Depends on Processor) Technology between iGPU and dGPU</td>
</tr>
<tr>
<td><strong>Intel® Core™ i5-6300HK (2.3GHz)</strong>&lt;br&gt;6MB Smart Cache, 14nm (14 Nanometer), DDR3L-1600MHz, TDP 45W</td>
<td></td>
<td><strong>nVIDIA® GeForce GTX 960M</strong>&lt;br&gt;PCle * 8 Video Chip&lt;br&gt;2GB GDDR5 Video RAM On Board&lt;br&gt;Supports Microsoft DirectX® 12&lt;br&gt;Battery Boost 2.0 Ready&lt;br&gt;NVIDIA PhysX™&lt;br&gt;GeForce CUDA™ Technology</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Core Logic</th>
<th>Display</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile Intel® HM170 Express Chipset</td>
<td><strong>Models A &amp; B:</strong>&lt;br&gt;15.6&quot; (39.62cm) QFHD (3840 * 2160) / FHD (1920 * 1080), 3.5 mm, 16:9 Backlit Panel</td>
<td>One Changeable 2.5&quot; 7mm/9.5mm (h) Hard Disk Drives (HDD) / Solid State Drives (SSD) with SATA Interface</td>
</tr>
<tr>
<td><strong>Model C:</strong>&lt;br&gt;17.3&quot; (43.94cm) FHD (1920 * 1080), 6.0mm, 16:9 Backlit Panel</td>
<td></td>
<td>One Changeable 9.5mm(h) Super Multi Optical Device Drive with SATA Interface (Factory Option)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video Adapter Options</th>
<th>Storage</th>
<th>BIOS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intel® HD Graphics 530</strong>&lt;br&gt;Dynamic Frequency&lt;br&gt;Intel® Dynamic Video Memory Technology Supporting Shared Memory Technology Supporting Shared Memory</td>
<td>One Changeable Caddy Bay 9.5 mm (h) Optical Device Drive (ODD), 2.5&quot;, 7.0mm (H) HDD/SSD with SATA Interface (Factory Option)</td>
<td>One 64Mb SPI Flash ROM&lt;br&gt;AMI BIOS</td>
</tr>
<tr>
<td><strong>nVIDIA® GeForce CUDA™ Technology</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Specifications

Audio
- High Definition Audio
- S/PDIF Digital Output
- Built-In Array Microphone
- 2 Built-In 2W Speakers
- Sound Blaster™ Cinema 2
- ANSP™ 3D Sound Technology on Headphone Output

Keyboard & Pointing Device
- Full Size Isolated White LED Illuminated Keyboard with Numeric Pad
- Built-In TouchPad (with Multi Gesture & Scrolling Functionality)

Indicators
- LED Indicators - Power/Suspend, Battery, HDD, Airplane Mode, Num Lock, Caps Lock, Scroll Lock, Camera

Interface
- Four USB 3.0 Ports
- One Mini Display Port 1.2
- One HDMI™ (High-Definition Multimedia Interface) Out Port (with HDCP)

Card Reader
- Embedded Multi-In-1 Push-Push Card Reader
  - MMC / RSMMC
  - SD / Mini SD / SDHC / SDXC
- Card Reader Note: Some of the cards require PC adapters that are usually supplied with the cards.

Slots
Models A & B - Three M.2 Slots:
- Slot 1: for M.2 2230 WLAN Combo Module Card with PCIe & USB Interfaces
- Slot 2: for M.2 2280 SSD Card with SATA/PCIe Gen x3/x4 Interface
- Slot 3: for LTE/HSPA+ M.2 3042 3G or 4G Module Card with USB Interface (Factory Option)

Model C - Two M.2 Slots:
- Slot 1: for M.2 2230 WLAN Combo Module Card with PCIe & USB Interfaces
- Slot 2: for M.2 2280 SSD Card with SATA/PCIe Gen x3/x4 Interface

Communication
- Built-In 10/100/1000Mb Base-TX Ethernet LAN
- 2.0M FHD PC Video Camera Module
- Intel® Dual Band Wireless-AC 8260 (2*2 802.11 a/c) M.2 WLAN + Bluetooth Combo M.2 2230 Module (Factory Option)
- Intel® Dual Band Wireless-AC 7265 (2*2 802.11 a/c) M.2 WLAN + Bluetooth Combo M.2 2230 Module (Factory Option)
- Intel® Dual Band Wireless-N 7265 (2*2 802.11 b/g/n) M.2 WLAN + Bluetooth Combo M.2 2230 Module (Factory Option)
- Intel® Dual Band Wireless-AC 3165 (1*1 802.11 ac) M.2 WLAN + Bluetooth Combo M.2 2230 Module (Factory Option)

See over
## Specifications

**Qualcomm® Atheros Killer™ Wireless-AC 1535 Dual Band (2*2 802.11 ac)**  
WLAN + Bluetooth Combo M.2 1630 Module *(Factory Option)*  

**3rd Party Combo WLAN (802.11b/g/n) and Bluetooth v4.0+LE Combo M.2 2230 Module (Factory Option)*

**For Model A Only:**  
3G UTMS/HSPA+ M.2 3042 Card Module *(Factory Option)*  
4G LTE M.2 3042 Card Module *(Factory Option)*

**Operating System**  
Windows® 10 (64-bit)

**Features**  
Painted Style  
Shipping Mode

**Security**  
Security (Kensington® Type) Lock Slot  
BIOS Password  
Intel® PTT for Systems without TPM  
Fingerprint Reader Module *(Factory Option)*  
Trusted Platform Module 2.0 *(Factory Option)*

### Power Management
- Supports Wake on LAN (AC Mode Only)  
- Supports Wake on USB  
- Supports Wake on RTC Alarm (AC Mode Only)

### Power
- Built-in 6 Cell Smart Lithium Ion Battery Pack 62WH  
- Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz DC Output 19.5V, 6.15A (120 Watts)

### Environmental Spec
- Temperature  
  Operating: 10°C - 35°C  
  Non-Operating: -20°C - 60°C  
- Relative Humidity  
  Operating: 20% - 80%  
  Non-Operating: 10% - 90%

### Physical Dimensions & Weight

<table>
<thead>
<tr>
<th>Model</th>
<th>Dimensions (w) * (d) * (h)</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Models A &amp; B:</strong></td>
<td>385mm * 268mm * 28.5mm</td>
<td>2.5kg *Barebone System with VGA Card &amp; Battery</td>
</tr>
<tr>
<td><strong>Model C:</strong></td>
<td>413mm * 285mm * 31.9mm</td>
<td>2.9kg *Barebone System with VGA Card &amp; Battery</td>
</tr>
</tbody>
</table>

*Weight tolerance within +/- 5%.

*A barebone system does not include the HDD, RAM, adapter, power cord and factory option modules.*